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Introduction
Although personal computers (PCs) have been around for a few decades, they
have been rapidly evolving in terms of their speed, power, and usefulness. With
PCs, you can professionally create and edit documents, manage finances, and
correspond with others through e-mail. To get the most out of your high-tech
experience, it is important that you stay current by knowing how to troubleshoot
common problems and how to upgrade your hardware to extend the life of your
PC. This book discusses a wide range of topics related to PC usage and mainte-
nance, such as:

• Analyzing your PC: Learn valuable information about your PC that
can help you determine what to upgrade.

• Upgrading your hardware: Replace outdated parts or add exciting,
new features.

• Knowing how to buy a new PC: With this valuable advice, you will
know exactly what features and options to look for when shopping for
a new PC.

• Connecting your PC to the Internet: Discover how easy it is to
connect your PC to the Internet.

• Using your PC: Learn some tips and tricks that will enable you to
operate your PC more effectively.

• Adding printers and other peripherals: Install helpful or fun
devices such as printers, video game controllers, and media players.

• Maintaining and troubleshooting your PC: Fix common prob-
lems and perform simple preventive maintenance to keep your PC in
tip-top shape.
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PART I
THE NUTS AND BOLTS 
OF PCS

From AGP cards to USB ports, the wide world of computer equipment is full of
confusing acronyms and tongue-twisting terminology. Fortunately, your friendly
neighborhood geeks from Geeks On Call are here to cut through the clutter and
explain the basics of personal computers (PCs). Whether you are interested in
buying a new computer or extending the life of your existing one, the informa-
tion in these chapters will ensure that you don’t have a hard time choosing
hardware.
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ANALYZING 
YOUR PC

Before upgrading your hardware, installing new soft-
ware, or troubleshooting a computer problem, you
need to know certain things about your PC — such as

what version of Windows or how much RAM you have.
Regardless of whether you tackle the computer work yourself
or hire certified professionals such as Geeks On Call to do it,
an analysis of your computer is the logical starting point.

Determine Your Version of Windows
Most computer programs and some pieces of hardware have
restrictions on what versions of Windows can be used with
them. To avoid buying products that won’t work with your
setup, you should determine what version of Windows you are
running.

1. Right-click the My Computer icon on your desktop.
If this icon is not available, then click the Start but-
ton in the lower-left corner of Windows and right-
click My Computer. If you can’t find the My
Computer icon anywhere, do the following:

a. Right-click in the empty space on your desktop.

b. Select Properties.

c. A window opens. Click the Desktop tab.

d. Near the bottom of the window, click the
Customize Desktop button.

e. Another window opens. On the General tab,
beneath the words Desktop Icons, place a
checkmark in the My Computer box.

f. Click OK.

g. You are returned to the previous screen. Click
Apply.

h. Click OK.

i. The My Computer icon appears on your desk-
top. Right-click it.

2. Select Properties.

Determine Your Version of
Windows

Determine Your Version of
Internet Explorer

Determine the
Manufacturer and Speed
of Your Processor (CPU)

Determine Your Amount
of System Memory (RAM)

Determine Your Hard
Drive’s Size and
Remaining Space

Open Your Computer’s
Case

Determine Your Hard
Drive’s Interface

Look for USP Ports

Identify Your Version of
USB

Look for FireWire Ports

Identify Your CD or DVD
Drive

Look for a Floppy Drive

Look for a Dial-Up Modem

Look for a Network Card

Identify Your Video Card

Determine the Video
Card’s Interface

Do It Yourself
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3. A window opens. Near the top of it, you should see the version of
Windows your computer is running as well as any “service packs”
(collections of updates and security patches) that have been installed
(see Figure 1-1).

Figure 1-1

Determine Your Version of Internet Explorer
Some software on your computer or certain Web sites you visit may require you
to use a certain version of Internet Explorer in order to function properly (or at
all). Here’s how to determine what version you have:

1. Double-click the Internet Explorer icon on your desktop. If this icon
is not available, click the Start button in the lower-left corner of
Windows and click on the shortcut labeled either Internet Explorer or
Internet.

2. Internet Explorer opens. Click the Help drop-down menu.

3. Click About Internet Explorer.

4. A window opens. Look for the word Version. Listed immediately next
to it will be the version number for your copy of Internet Explorer
(see Figure 1-2).

5. Click OK.

4 Part I • The Nuts and Bolts of PCs
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Figure 1-2

Determine the Manufacturer and Speed of Your
Processor (CPU)
The processor — also known as a CPU — is the part of your computer’s hard-
ware that performs the tasks handed out by your software. Typically, the faster a
processor is, the more powerful your computer will be. Some programs and
newer versions of Windows require a minimum CPU speed in order to work
correctly. To find out how fast your CPU is and which company made it, do the
following:

1. Right-click the My Computer icon on your desktop. If this icon is not
available, click the Start button in the lower-left corner of Windows
and right-click My Computer. If you can’t find the My Computer icon
anywhere, do the following:

a. Right-click in the empty space on your desktop.

b. Select Properties.

c. A window opens. Click the Desktop tab.

d. Near the bottom of the window, click the Customize Desktop
button.

e. Another window opens. On the General tab, beneath the words
Desktop Icons, place a checkmark in the My Computer box.

f. Click OK.

g. You are returned to the previous screen. Click Apply.

h. Click OK.

i. The My Computer icon appears on your desktop. Right-click it.

2. Select Properties.

3. A window opens. Near the bottom of it, you should see the name of the
company that made your CPU (usually it is Intel or AMD) as well as the
CPU’s speed listed in measurements of “MHz” (megahertz) or “GHz”
(gigahertz)—for example, 500 MHz or 1.5 GHz (see Figure 1-3).

Chapter 1: Analyzing Your PC 5
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Figure 1-3

Determine Your Amount of System Memory (RAM)
The memory in your computer — commonly referred to as RAM (Random
Access Memory) — is the hardware used by Windows and your software to store
temporary information. The more RAM you have, the more programs you can
use simultaneously and the faster your computer will be. Here’s how to find out
how much RAM your computer has:

1. Right-click the My Computer icon on your desktop. If this icon is not
available, click the Start button in the lower-left corner of Windows
and right-click My Computer. If you can’t find the My Computer
icon anywhere, do the following:

a. Right-click in the empty space on your desktop.

b. Select Properties.

c. A window opens. Click the Desktop tab.

d. Near the bottom of the window, click the Customize Desktop
button.

e. Another window opens. On the General tab, beneath the words
Desktop Icons, place a checkmark in the My Computer box.

f. Click OK.

g. You are returned to the previous screen. Click Apply.

h. Click OK.

i. The My Computer icon appears on your desktop. Right-click it.

2. Select Properties.

3. A window opens. Near the bottom of it, you should see the amount of
system memory (RAM). See Figure 1-4.

6 Part I • The Nuts and Bolts of PCs
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Figure 1-4

Determine Your Hard Drive’s Size and Remaining Space
A hard drive is a piece of equipment that stores all of the programs and data on
your computer (think of it as a digital warehouse). If your hard drive has too
much information on it, your computer can become noticeably slow. If the hard
drive becomes completely full, you will be unable to install new programs or
download files from the Internet until you free up some space. To determine the
overall size of your hard drive and how much room it has left, do the following:

1. Double-click the My Computer icon on your desktop. If this icon is
not available, click the Start button in the lower-left corner of
Windows and click My Computer. If you can’t find the My Computer
icon anywhere, do the following:

a. Right-click in the empty space on your desktop.

b. Select Properties.

c. A window opens. Click the Desktop tab.

d. Near the bottom of the window, click the Customize Desktop
button.

e. Another window opens. On the General tab, beneath the words
Desktop Icons, place a checkmark in the My Computer box.

f. Click OK.

g. You are returned to the previous screen. Click Apply.

h. Click OK.

i. The My Computer icon appears on your desktop. Double-click it.

2. A window opens. Right-click the icon for the hard drive you want to
check. For example, if you want to know the size and remaining space
for your C: drive (which is the drive that most people have Windows
installed on), then right-click the icon labeled C.

Chapter 1: Analyzing Your PC 7
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3. Select Properties.

4. A window opens. On the General tab, you should see the words Used
space.This indicates how much of your hard drive is being used.You
should also see the words Free space, which indicates how much room
is left on your hard drive (see Figure 1-5). Both of these numbers will
be expressed in measurements of gigabytes (GB) or megabytes (MB) —
for example, 500MB or 2GB. Don’t be alarmed if you see that your
gigabytes have a smaller number than your megabytes; a gigabyte is
much larger than a megabyte (one gigabyte is equal to 1,000
megabytes).

Figure 1-5

Open Your Computer’s Case
After you have used Windows to do a quick analysis of your PC’s primary fea-
tures, you should open the computer’s case and examine the equipment inside.
Becoming comfortable with opening the case and identifying the components is
essential if you ever want to perform a hardware upgrade on your own.

1. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

2. Examine your case to find out how it opens. Some cases have a
removable cover shaped like an upside-down “U” that slides off when
some screws are unfastened. Other cases have side panels (or doors)
that slide off or swing open when they are unscrewed or when a spe-
cial button is pressed.

3. If you cannot figure out how to open your computer’s case, check the
owner’s manual or documents that came with your system.

8 Part I • The Nuts and Bolts of PCs
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Determine Your Hard Drive’s Interface
All hard drives use special data cables to transfer information to and from the
rest of your computer. By finding out what type of interface those cables have,
you will be able to identify the style of your hard drive (which is crucial if you
ever decide to upgrade it to a faster model or add a second one).

1. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

2. Remove the computer’s cover.

3. Look for your hard drive (see Figure 1-6), which is one of the few
devices that have data cables (also called “ribbon” cables) and power
cables connected to them.

Figure 1-6

a. If the hard drive has a flat ribbon cable connected to it, you are
probably using an IDE or EIDE interface.

b. If the hard drive has a different type of data cable connected to
it (like a round one), you are probably using a Serial ATA 
interface.

Another way to determine your hard drive’s interface is to look in the Windows
Device Manager.

Chapter 1: Analyzing Your PC 9
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For Windows 2000 and Windows XP Home/Pro
1. Right-click the My Computer icon on your desktop. If this icon is not

available, click the Start button in the lower-left corner of Windows
and right-click My Computer. If you can’t find the My Computer
icon anywhere, do the following:

a. Right-click in the empty space on your desktop.

b. Select Properties.

c. A window opens. Click the Desktop tab.

d. Near the bottom of the window, click the Customize Desktop
button.

e. Another window opens. On the General tab, beneath the words
Desktop Icons, place a checkmark in the My Computer box.

f. Click OK.

g. You are returned to the previous screen. Click Apply.

h. Click OK.

i. The My Computer icon appears on your desktop. Right-click it.

2. Select Properties.

3. A window opens. Click the Hardware tab.

4. Click the Device Manager button.

5. Another window opens. Click the plus sign (+) located next to the
IDE ATA/ATAPI controllers category (see Figure 1-7).

Figure 1-7

6. You will see a list of the hard drive “channels” on your computer. An
IDE Channel indicates you are using an IDE hard drive. A Serial ATA
Channel indicates you are using a serial ATA hard drive.

10 Part I • The Nuts and Bolts of PCs
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For Windows 98 and ME
1. Right-click the My Computer icon on your desktop.

2. Select Properties.

3. A window opens. Click the Device Manager tab.

4. Click the plus sign (+) located next to the Hard disk controllers cate-
gory (see Figure 1-8).

Figure 1-8

5. You will see a list of the hard drive “channels” on your computer. An
IDE Channel indicates you are using an IDE hard drive. A Serial ATA
Channel indicates you are using a serial ATA hard drive.

Look for USB Ports
Most modern computer peripherals such as printers and digital cameras connect
to computers through USB ports. Determining whether or not your computer is
equipped with USB will tell you what devices and gadgets can be used with your
computer.

1. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

2. Pull your computer away from your desk so you can get a good look at
its case. On the back of the computer, search for a thin, rectangular
connector (see Figure 1-9). That is a USB port, into which you can
plug USB devices such as printers, keyboards, mice, digital cameras,
and much more.

Chapter 1: Analyzing Your PC 11

05_77989x ch01.qxp  11/10/05  6:49 PM  Page 11



Figure 1-9

3. If you cannot find any USB ports on the back of your computer, look
at the front of the case. Some computers have these ports hidden
behind doors or panels that swing open (see Figure 1-10).

Figure 1-10

12 Part I • The Nuts and Bolts of PCs
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Identify Your Version of USB
There are two versions of USB: 1.1 (somewhat slow) and 2.0 (very fast).
Although their speeds are different, both USB formats are compatible with each
other (which means you can plug a 1.1 device into a 2.0 port or vice versa).
Identifying the speed of the USB ports on your computer can be quite helpful
when deciding what type of peripherals to purchase. For example, if your com-
puter has USB 2.0, you should buy a digital camera that also has USB 2.0 so
you can transfer photos from the camera to your computer at the highest possi-
ble speed. To determine which version of USB you have, use the Windows
Device Manager.

Note 
Plugging a 1.1 device into a 2.0 port will not make that device perform faster.
However, plugging a 2.0 device into a 1.1 port will cause the 2.0 device to perform
slower. 

For Windows 2000 and Windows XP Home/Pro
1. Right-click the My Computer icon on your desktop. If this icon is not

available, click the Start button in the lower-left corner of Windows and
right-click My Computer. If you can’t find the My Computer icon
anywhere, do the following:

a. Right-click in the empty space on your desktop.

b. Select Properties.

c. A window opens. Click the Desktop tab.

d. Near the bottom of the window, click the Customize Desktop
button.

e. Another window opens. On the General tab, beneath the words
Desktop Icons, place a checkmark in the My Computer box.

f. Click OK.

g. You are returned to the previous screen. Click Apply.

h. Click OK.

i. The My Computer icon appears on your desktop. Right-click it.

2. Select Properties.

3. A window opens. Click the Hardware tab.

4. Click the Device Manager button.

5. Another window opens. Click the plus sign (+) located next to the
Universal Serial Bus controllers category (see Figure 1-11).

Chapter 1: Analyzing Your PC 13
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Figure 1-11

6. To determine if you have the fastest version of USB (called USB 2.0),
look for an “enhanced” USB controller with a name like Standard
Enhanced PCI to USB Host Controller, Intel PCI to USB Enhanced
Host Controller, or NEC PCI to USB Enhanced Host Controller. If
you do not see the word “enhanced,” you probably have USB 1.1 (the
slower version).

For Windows 98 and ME
1. Right-click the My Computer icon on your desktop.

2. Select Properties.

3. Click the Device Manager tab.

4. Click the plus sign (+) located next to the Universal serial bus con-
trollers category (see Figure 1-12).

Figure 1-12

14 Part I • The Nuts and Bolts of PCs
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5. To determine if you have the fastest version of USB (called USB 2.0),
look for an “enhanced” USB controller with a name like Standard
Enhanced PCI to USB Host Controller, Intel PCI to USB Enhanced
Host Controller, or NEC PCI to USB Enhanced Host Controller. If
you do not see the word “enhanced,” you probably have USB 1.1 (the
slower version).

Look for FireWire Ports
FireWire is another type of connection used to transfer information between a
computer and a peripheral such as an external hard drive or a video camera. The
speed of FireWire is similar to that of USB 2.0. To discover if your computer is
FireWire-capable, do the following:

1. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

2. Pull your computer away from your desk so you can get a good look at
its case. On the back of the computer, search for a connector that
looks like Figure 1-13. That is a FireWire port, into which you can
plug FireWire devices such as digital video cameras, external DVD
drives, external hard drives, and much more.

Figure 1-13

3. If you cannot find any FireWire ports on the back of your computer,
look at the front of the case. Some computers have these ports hidden
behind doors or panels that swing open.
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Identify Your CD or DVD Drive
CD-ROM drives sure have come a long way since their humble beginnings.
Now there are recordable and rewritable compact discs (CD-R and CD-RW), as
well as their offspring: recordable and rewritable DVDs (DVD-R, DVD-RW,
DVD+R, DVD+RW). Once you determine what type of CD or DVD drive is
inside your computer, you will know which discs to buy and what software can
be used with the drive.

1. Look at the front of your CD or DVD drive. Often there are words or
logos that indicate the drive’s capabilities or features.

2. If you have a CD drive, you should see a Compact Disc logo.

Note
All CD drives play music CDs and read CD-ROM data discs.

3. If you have a DVD drive, you will probably see a DVD logo.

Note
In addition to reading DVD-ROM data discs and playing DVD movies, a DVD drive
is backwards compatible with CDs. That means it can play music CDs and read
CD-ROM data discs. 

4. If you have a CD or DVD burner that can record data onto writable
or rewritable CD or DVD discs, that feature should be indicated by a
logo labeled RW or Rewritable.

If you do not see any words or logos on the front of your CD or DVD drive, you
can search for information about it in the Windows Device Manager.

For Windows 2000 and Windows XP Home/Pro
1. Right-click the My Computer icon on your desktop. If this icon is not

available, click the Start button in the lower-left corner of Windows
and right-click My Computer. If you can’t find the My Computer
icon anywhere, do the following:

a. Right-click in the empty space on your desktop.

b. Select Properties.

c. A window opens. Click the Desktop tab.

d. Near the bottom of the window, click the Customize Desktop
button.

e. Another window opens. On the General tab, beneath the words
Desktop Icons, place a checkmark in the My Computer box.

f. Click OK.

g. You are returned to the previous screen. Click Apply.

h. Click OK.

i. The My Computer icon appears on your desktop. Right-click it.
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2. Select Properties.

3. A window opens. Click the Hardware tab.

4. Click the Device Manager button.

5. Another window opens. Click the plus sign (+) located next to the
DVD/CD-ROM drives category (see Figure 1-14).

Figure 1-14

6. You should see a DVD/CD icon, next to which is the name of your
DVD or CD drive as well as its model number. If not, do the following:

a. Double-click the DVD/CD icon.

b. A window opens. On the General tab, look for the name and
model of you drive.

c. If you still can’t find it, click the Details tab and look there.

For Windows 98 and ME
1. Right-click the My Computer icon on your desktop.

2. Select Properties.

3. A window opens. Click the Device Manager tab.

4. Click the plus sign (+) located next to the CDROM category (see
Figure 1-15).

5. You should see a CD icon, next to which is the name of your CD or
DVD drive as well as its model number. If not, do the following:

a. Double-click the CD icon.

b. A window opens. On the General tab, look for the name and
model of you drive.

c. If you still can’t find it, click the Details tab and look there.
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Figure 1-15

Look for a Floppy Drive
Although the old-fashioned floppy disk is rarely used anymore, many modern
computers still have floppy drives (just in case someone needs to access an old
file from 15 years ago that was stored on a floppy). If you aren’t sure whether
your computer has a floppy drive, do the following:

1. On the front of your computer, look for a slot about three-and-a-half
inches long and about half an inch tall (see Figure 1-16).

Figure 1-16
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2. Look for an eject button nearby.

3. Look for an LED status light (which lights up only when the floppy
drive is being used).

Look for a Dial-Up Modem
Although the rising popularity of high-speed Internet is gradually pushing slow
dial-up Internet services into retirement, most new computers still come
equipped with dial-up modems. That way, people have the option to sign up for
an inexpensive Internet service in exchange for a slow speed. Here’s how you
can check for a dial-up modem in your computer:

1. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

2. Pull your computer away from your desk so you can get a good look at
its case. On the back of the computer, search for the section that has
two telephone jacks (see Figure 1-17). These will be identical to the
connectors on a standard telephone as well as the telephone jacks
found in the walls of your home or office.

Figure 1-17

Look for a Network Card
A network card (also called an Ethernet card) is a device that enables a com-
puter to connect to a high-speed Internet service such as DSL or cable. In addi-
tion, some modern computers have Wi-Fi (wireless) cards that allow them to
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access computer networks and surf the Internet from any room in the house —
without using Ethernet cables or connectors. To check for an Ethernet or Wi-Fi
card, do the following:

1. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

2. Pull your computer away from your desk so you can get a good look
at its case. On the back of the computer, search for an opening that
looks like it connects to a very fat telephone cord (see Figure 1-18).
This is an Ethernet jack, into which you can connect an Ethernet
cable that will deliver high-speed Internet access and connect you to a
computer network.

Figure 1-18

3. If the back of your computer has a card with an antenna sticking out
of it (see Figure 1-19), you have a wireless (Wi-Fi) network card.You
can use it to connect to wireless computer networks and receive wire-
less high-speed Internet connections.
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Figure 1-19

Identify Your Video Card
Year after year, one of the most popular reasons for using a computer continues
to be video games. And with each passing year, the graphics in those games
grow more realistic and complex, requiring a powerful video card in order to
play properly. To see if your current video card is up to the challenge, compare
its specifications to the video game’s minimum hardware requirements. In par-
ticular, pay attention to the amount of video RAM your card has compared to
how much the game requires. Here’s how to find your specs.

For all Windows versions
1. Right-click in the empty space on your desktop.

2. Select Properties.

3. A window opens. Click the Settings tab.

4. Click the Advanced button.

5. Another window opens. Click the Adapter tab (see Figure 1-20).

6. Based on your version of Windows, you should see a heading called
something like Adapter Type. There you will learn the make and
model of your video card.You might also see a heading called some-
thing like Adapter Information, which will tell you more information
about the video card’s manufacturer as well as the speed and the
amount of RAM the card has.

Chapter 1: Analyzing Your PC 21

05_77989x ch01.qxp  11/10/05  6:49 PM  Page 21



Figure 1-20

Determine the Video Card’s Interface
If you want to upgrade to a more powerful video card or replace one that has bro-
ken, you need to know what type of interface it uses to connect to your computer.

1. Look for information in the owner’s manual or documents that came
with your computer. If they are not helpful — or if you have misplaced
them — you can inspect the hardware inside your computer to deter-
mine which video-card interface you have.

2. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

3. Remove the computer’s cover.

4. Locate your video card by following the thick cable that goes from
your monitor to the back of your computer. After you have pinpointed
your video card, you need to figure out which interface it uses. Here
are the three types:

• PCI: This is the traditional interface that has existed in comput-
ers for well over a decade. It is used to connect multiple types of
hardware such as video cards, sound cards, modems, and more.
Usually it has a beige-colored slot that is approximately 3.25
inches wide. Also, most computers have several PCI slots that are
stacked in a vertical or horizontal row. So if you see a group of
slots neatly lined up, those are probably PCI slots.

• AGP: This interface is used for modern, high-speed video cards.
Often it has a brown- or black-colored slot that is nearly 4 inches
wide. Most computers have only one AGP slot.

• PCI Express (PCIe): This cutting-edge interface is beginning to
appear in new computers. Its slots are noticeably smaller than those
belonging to the old-fashioned PCI interface. Unless your computer
was made in the past year or so, it is unlikely you have PCI Express.
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2
UPGRADING 
YOUR PC

Have you ever thrown away an automobile because of a
flat tire? Of course not. Then why get rid of a com-
puter just because some of its parts have malfunc-

tioned? Much like a car, a computer has many removable parts
that can be replaced or upgraded to provide extra speed,
power, or storage. Here are the two biggest reasons for upgrad-
ing a computer:

• Saves money: A new computer usually costs
between $500 and $2,000. However, upgrading
some of the important parts on a computer can be
done for as little as $100. Why is there such a differ-
ence? First of all, most new computers come as a
complete package, meaning that along with the base
unit they include a monitor, keyboard, mouse, and
perhaps a printer. If you already have those other
items and they are working fine, why replace them?
Second, much of the cost of a new computer reflects
the time and effort someone spent assembling and
configuring it. If you can do the labor yourself, you
can save significant dollars. Think of it as a home-
improvement project: why hire someone when you
can do it yourself?

• Saves time: When you buy a new computer, it’s
like buying a new house — you have to move in all
of your belongings and decorate it. In computer
terms, that means installing all of your software on
the new machine, such as Microsoft Word and other
Microsoft Office programs, financial or tax software,
video games, and so on; transferring all of your files
from your old PC to your new one; setting up your
e-mail, Internet, and instant-messaging accounts on
your new system; and much more. This process is
often very time consuming and frustrating.

Do it yourself or call
Geeks On Call?

What should be
upgraded? 

Upgrade to 
Windows XP

Add more system
memory (RAM)

Add an internal 
hard drive

Add an external 
hard drive

Add a USB card 

Add a FireWire card 

Add a CD or DVD drive

Replace your floppy
drive

Add a dial-up modem

Add a network card

Replace your video
card

Replace your sound
card

Do It Yourself
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Do It Yourself or Call “Geeks On Call”?
If the thought of fiddling with the insides of a computer makes you cringe, don’t
worry — you can always have Geeks On Call come to your home or office to
take care of your high-tech needs. However, if you feel a bit adventurous and
want to get your hands dirty (metaphorically speaking), then pay close attention
to the advice and 5-minute fixes in this book. If you are unsure which group you
belong to, consider the necessary attributes of a digital do-it-yourselfer:

• Basic understanding of a PC:You should know how to unplug and
reattach the cables and cords on the back of a computer and how to
open the computer’s case in order to access its internal parts.

• Ability to follow step-by-step instructions:You must be able to
pay close attention and carefully follow the detailed directions listed
in this book in order to prevent the upgrade from failing and possibly
damaging the PC.

• Asking for help:You should be willing to seek professional high-tech
help when upgrades don’t work properly (which also will help to pre-
vent the PC from being damaged).

What Should Be Upgraded?
The top questions asked by most digital do-it-yourselfers are “When do I need
to upgrade?” and “What parts should be upgraded?” Here are some common
PC problems and the hardware or software upgrades that might fix them:

• Problem: The computer takes an unusually long time to start up, to
shut down, or to open programs and folders. Also, the computer feels
sluggish.

Solution: Upgrade to a faster processor (CPU), or add more system
memory (RAM).

• Problem: The computer frequently freezes or crashes, often resulting
in error messages or blue screens displaying strange text.

Solution: Update or reinstall Windows, or add more system memory
(RAM).

• Problem: Messages warn that the computer is running low on disk
space or doesn’t have enough room to install a program.

Solution: Upgrade to a larger hard drive, or add a second hard
drive.

Upgrade to Windows XP
If you are using an outdated version of Windows such as 95, 98, or ME, con-
sider upgrading to the most recent version: XP. Windows XP makes it easy to
use peripherals such as digital cameras and printers, to connect to wireless net-
works, and so much more. But above all else, XP is more stable and safe than its
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predecessors, which means you won’t have to endure the frequent “blue screens
of death” that plagued Windows 95 and 98. Here are the basic steps to take
when upgrading to Windows XP:

Note
Windows XP has certain requirements about the type of hardware it can be used
with. To see if your computer is compatible with XP, follow the steps in Chapter 1 to
analyze your PC, and then compare your results to the requirements listed on XP’s
package. 

1. Determine which version of Windows your computer is currently run-
ning. For more information, refer to the 5-minute fix “Determine Your
Version of Windows” found in Chapter 1.

2. Find out how fast your CPU is and how much RAM you have. For
more information, refer to the 5-minute fixes “Determine the
Manufacturer and Speed of Your Processor (CPU)” and “Determine
Your Amount of System Memory (RAM)” found in Chapter 1.

3. Determine how much hard drive space you have left. For more infor-
mation, refer to the 5-minute fix “Determine Your Hard Drive’s Size
and Remaining Space” found in Chapter 1 .

4. Carefully examine the hardware requirements for the version of
Windows you are considering upgrading to because newer versions
such as Windows XP require a minimum amount of RAM, hard drive
space, and CPU speed in order to function properly.

5. If you are thinking about upgrading to Windows XP, you must decide
whether you want the Home Edition or the Professional Edition. XP
Pro costs about $100 more and offers several features not found in
XP Home, such as encryption for files and folders. Many advanced
users or businesses will benefit from these extra features, but the aver-
age home user can usually get by without them.

6. If you plan to upgrade to XP Home or Pro from an older version of
Windows (such as 98), you should use Microsoft’s Upgrade Advisor
to determine which of your older programs or hardware items will not
run properly on XP. Visit www.microsoft.com/windowsxp/home/
upgrading/advisor.mspx to download the Advisor.

7. Back up your important files and documents to prevent them from
being accidentally damaged or erased when you perform the Windows
upgrade. Although such a problem is rare, it is always a good idea to
back up your valuable data just to be safe. Backups can be done by
using an external hard drive, CD/DVD burner, USB thumbdrive, or
tape drive along with backup or burning software such as Norton
Ghost or Nero Burning ROM.

8. To ensure a successful upgrade, carefully follow the printed instructions
— as well as any onscreen instructions — that came with your new ver-
sion of Windows.
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Add More System Memory (RAM)
An inexpensive way to add some zip to your computer is
to install more system memory (RAM). Along with the
extra speed, you will be able to use more programs at the
same time (such as checking e-mail while surfing the
Internet while listening to digital music files).

1. Determine what type of RAM your computer uses
by reading the owner’s manual or documents that
came with your system. Another way to find this
information is to visit www.powerleap.com and use
its upgrade advisor to automatically detect your
system settings and tell you which types of RAM
are compatible with your computer.

2. Purchase a new stick of RAM from a computer or electronics store or
from an Internet retailer such as Newegg.com (www.newegg.com).
Often an Internet store can save you quite a bit of money compared to
its brick-and-mortar counterparts.

3. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

4. Disconnect all wires and cables from the back of the computer’s base
unit, and then place the unit on a wooden floor or table. Do not
attempt to perform any hands-on computer work while standing or
sitting on a carpet or rug. Doing so can generate static electricity that
can travel from your body into the computer and damage or destroy
your hardware.

5. Remove the computer’s cover. For more information, refer to the 
5-minute fix “Open Your Computer’s Case” in Chapter 1.

6. Locate the memory slots (see Figure 2-1). Typically, there are between
two and four of them sitting side by side. To get a clear look at these
slots, you might need to move some wires or cables out of the way. If
you are simply adding more RAM to your existing RAM, proceed to
Step 8. If you are upgrading to a faster type of RAM, you will need to
remove your current RAM before you can install the new one
(because if fast RAM is mixed with slower RAM, the fast RAM will
drop its speed to match that of the slower RAM). For details on
removing RAM, proceed to Step 7.

7. To remove a stick of RAM, push down the two small plastic arms that
hold the RAM in place. One arm is located on each end of the mem-
ory slot and is typically white or beige in color.

8. To install a new stick of RAM, remove it from its protective bag or
container. When handling RAM, touch only the smooth sides that do
not have circuits printed on them. Do not touch anywhere else,
because doing so might damage the RAM.
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If you are upgrading 
to Windows XP from
an older model of
Windows, you can save
a substantial amount of
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the version of XP
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of XP.
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Figure 2-1

9. Line up the stick of RAM with the memory slot. Both of them are
designed so that you can only insert the RAM a certain way. Firmly
but gently push the RAM into the slot until both of the slot’s plastic
arms click into place (see Figure 2-1).

10. If any wires or cables inside the computer were accidentally discon-
nected while installing the RAM, reconnect them.

11. Close the case, and then return the base unit to your desk.

12. Reconnect the wires and cables into the back of the base unit, and then
plug the computer into an electrical outlet and turn it on.When your
computer starts, it should instantly recognize the new RAM. If the
RAM isn’t recognized, your computer most likely will not start at all.

Add an Internal Hard Drive
If your computer is several years old, you probably have a small hard drive that
is quickly running out of storage space. Replacing your current hard drive or
adding an additional one will give you ample room to store your growing collec-
tion of documents, digital photos, digital music, videos, and software.

Note
It is much easier to add a second hard drive than to replace your current one.

1. Find out what type of hard drive your computer uses by referring to
the 5-minute fix “Determine Your Hard Drive’s Interface” in Chapter
1. Another way to find this information is to visit www.powerleap.com
and use its upgrade advisor to automatically detect your system set-
tings and tell you what type of hard-drive interface you have.
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2. Purchase a new hard drive from a computer or electronics store or
from an Internet retailer such s Newegg.com (www.newegg.com).
Often an Internet store can save you quite a bit of money compared to
its brick-and-mortar counterparts.

3. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

4. Disconnect all wires and cables from the back of the computer’s base
unit, and then place the unit on a wooden floor or table. Do not
attempt to perform any hands-on computer work while standing or
sitting on a carpet or rug. Doing so can generate static electricity that
can travel from your body into the computer and damage or destroy
your hardware.

5. Remove the computer’s cover. For more information, refer to the 
5-minute fix “Open Your Computer’s Case” found in Chapter 1.

6. If your new hard drive is intended to replace your current hard drive,
then you will need to purchase special software such as Norton Ghost
(available at www.symantec.com) to help you copy all of the files from
the old drive to the new one. If your new hard drive is not going to
replace your current one but rather is intended to work alongside it
and provide extra storage space, proceed to the next step.

7. On the rear of the new hard drive is a tiny plastic “jumper” that must
be placed onto the small metal pins in a specific way to allow the drive
to work side by side with your current hard drive. On top of most
hard drives is a diagram or picture that shows where to place the
jumper to make the drive a “slave.” Follow these instructions to make
your new drive a slave.

8. You probably need to change the jumper settings on your old hard
drive so it works properly with the new drive. Look at the diagram or
picture on top of the old drive. If you cannot see the picture, you
might have to unscrew and remove the drive from your computer. The
picture will probably show different jumper settings for “Single” and
“Master.” Examine the jumper on your old drive. If it is set to
“Single,” that means it is configured to operate by itself (without any
slave drives).You need to move the jumper to the “Master” position as
indicated by the picture.

9. Connect a data cable to the new hard drive. For an EIDE drive, find
the ribbon cable connected to your existing hard drive, and then use
the gray connector in the middle of it to connect to your new hard
drive. For a Serial ATA (SATA) drive, connect the cable that came
with the drive to an SATA port on your motherboard.

10. Connect a power cable to the new hard drive. Usually, all computers
have extra power cables tucked away inside their cases.

11. Find an empty mounting bay inside the computer’s case, and then
slide the new hard drive into the bay and secure it (usually by screw-
ing the drive to the case).
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12. If any wires or cables inside the computer were accidentally discon-
nected while installing the new hard drive, reconnect them.

13. Close the case, and then return the base unit to your desk.

14. Reconnect the wires and cables into the back of the base unit, and
then plug the computer into an electrical outlet and turn it on. When
your computer starts, it should instantly detect your new hard drive.

15. Before you can use the new hard drive, you will probably need to for-
mat it. Double-click the My Computer icon on your desktop. If this
icon is not available, click the Start button in the lower-left corner of
Windows and click My Computer. If you can’t find the My Computer
icon anywhere, do the following:

a. Right-click in the empty space on your desktop.

b. Select Properties.

c. A window opens. Click the Desktop tab.

d. Near the bottom of the window, click the Customize Desktop
button.

e. Another window opens. On the General tab, beneath the words
Desktop Icons, place a checkmark in the My Computer box.

f. Click OK.

g. You will be returned to the previous screen. Click Apply.

h. Click OK.

i. The My Computer icon appears on your desktop.
Double-click it.

16. A window opens. Right-click the icon for your new hard drive.

17. Select Format.

18. Follow the onscreen instructions to format the drive.

Add an External Hard Drive
The easiest way to add extra storage to your crowded
computer is to buy an external hard drive. Basically this
device is a standard hard drive enclosed in a rugged plastic
or metal case that protects it from being damaged. The
best thing is that it connects to your computer through
USB or FireWire ports — which means you don’t have to
open your computer’s case and tinker with its internal
components.

1. Purchase an external hard drive from a computer
or electronics store or from an Internet retailer
such as Newegg.com (www.newegg.com). Often
an Internet store can save you quite a bit of
money compared to its brick-and-mortar 
counterparts.
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It’s a Fact
Modern computer
programs use more
hard drive space than
ever before. For
example, the popular
video game Sims 2
requires 3.5GB, and
Microsoft’s Streets
and Trips (a travel
planner) requires
1GB. These two pro-
grams alone could
gobble up half the
space on many older
hard drives.
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2. If the external hard drive has a USB connector, simply connect one
end of the USB cable to the drive and the other end to a USB port on
your computer (see Figure 2-2). If the external hard drive has a
FireWire connector, simply connect one end of the FireWire cable to
the drive and the other end to a FireWire port on your computer.

Figure 2-2

3. Connect the power cable to the external hard
drive, and then plug it into an electrical outlet.

4. Windows should automatically detect the external
hard drive and enable you to use it right away.

Add a USB Card
USB is the type of connection used by almost all com-
puter peripherals including printers, digital cameras, and
scanners. If you have an older computer that lacks USB
ports — or if you need extra ports — you can install a 
USB card.

Note
For the fastest speed, buy a USB 2.0 card.

1. Purchase a USB card from a computer or electronics store or from an
Internet retailer such as Newegg.com (www.newegg.com). Often, an
Internet store can save you quite a bit of money compared to its
brick-and-mortar counterparts.
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documents from being
lost forever as a result
of a hard-drive crash,
use an external hard
drive and special
backup software such
as Norton Ghost
(www.symantec.com)
to make a copy of
your data.
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2. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

3. Disconnect all wires and cables from the back of the computer’s base
unit, and then place the unit on a wooden floor or table. Do not
attempt to perform any hands-on computer work while standing or
sitting on a carpet or rug. Doing so can generate static electricity that
can travel from your body into the computer and damage or destroy
your hardware.

4. Remove the computer’s cover. For more information, refer to the 
5-minute fix “Open Your Computer’s Case” in Chapter 1.

5. Locate an empty PCI slot (see Figure 2-3), and then remove the slot’s
metal or plastic cover by unfastening the screw or plastic arm that
holds it in place.

Figure 2-3

6. Firmly but gently insert the USB card into the empty PCI slot.

7. Secure the USB card by fastening a screw (see Figure 2-4) or snap-
ping the plastic arm back into place.

8. If any wires or cables inside the computer were accidentally discon-
nected while installing the USB card, reconnect them.

9. Close the case, and then return the base unit to your desk.

10. Reconnect the wires and cables into the back of the base unit, and
then plug the computer into an electrical outlet and turn it on.

11. After Windows detects the new USB card, it searches for a “driver” to
finish the setup. If the correct driver isn’t found, you will need to
install it by using the setup CD that came with the USB card.
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Figure 2-4

Add a FireWire Card
FireWire is another type of high-speed connection used by many computer
peripherals such as external hard drives and video cameras. (However, FireWire
is not used with as many peripherals as USB is.) Similar to USB, FireWire capa-
bilities can be added to a computer by installing a special card.

1. Purchase a FireWire card from a computer or electronics store or
from an Internet retailer such as Newegg.com (www.newegg.com).
Often an Internet store can save you quite a bit of money compared to
its brick-and-mortar counterparts.

2. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

3. Disconnect all wires and cables from the back of the computer’s base
unit, and then place the unit on a wooden floor or table. Do not
attempt to perform any hands-on computer work while standing or
sitting on a carpet or rug. Doing so can generate static electricity that
can travel from your body into the computer and damage or destroy
your hardware.

4. Remove the computer’s cover. For more information, refer to the 
5-minute fix “Open Your Computer’s Case” in Chapter 1.

5. Locate an empty PCI slot (see Figure 2-5), and then remove the slot’s
metal or plastic cover by unfastening the screw or plastic arm that
holds it in place.
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Figure 2-5

6. Firmly but gently insert the FireWire card into the empty PCI slot.

7. Secure the FireWire card by fastening a screw (see Figure 2-6) or by
snapping the plastic arm back into place.

Figure 2-6
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8. If any wires or cables inside the computer were accidentally discon-
nected while installing the FireWire card, reconnect them.

9. Close the case, and then return the base unit to your desk.

10. Reconnect the wires and cables into the back of the base unit, and
then plug the computer into an electrical outlet and turn it on.

11. After Windows detects the new FireWire card, it searches for a
“driver” to finish the setup. If the correct driver isn’t found, you need
to install it by using the setup CD that came with the FireWire card.

Add a CD or DVD Drive
Have you ever wanted to watch a DVD movie on your computer or make your
own custom music CDs? With a modern CD or DVD drive, both activities are
possible — and much more. Here are the different types of CD or DVD drives
currently available:

• Read-Only: These drives can only read information on prerecorded
discs. Examples include CD-ROM and DVD-ROM.

• Recordable or rewritable: These drives can read data on prere-
corded discs and write (or “burn”) data onto blank discs. Examples
include CD-R, CD-RW, DVD-R, DVD-RW, DVD+R, and
DVD+RW. Most of these drives are restricted to using one type of
disc. That means “minus R” (-R) drives cannot use “plus R” (+R)
discs, and vice versa.

• Combo drives: These drives can read and burn data on any type of
disc. They are an ideal choice for people who don’t want to worry
about what type of discs to buy.

To install a CD or DVD drive in your computer, do the following:

1. Purchase a CD or DVD drive from a computer or electronics store or
from an Internet retailer such as Newegg.com (www.newegg.com).
Often an Internet store can save you quite a bit of money compared to
its brick-and-mortar counterparts.

2. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

3. Disconnect all wires and cables from the back of the computer’s base
unit, and then place the unit on a wooden floor or table. Do not
attempt to perform any hands-on computer work while standing or
sitting on a carpet or rug. Doing so can generate static electricity that
can travel from your body into the computer and damage or destroy
your hardware.

4. Remove the computer’s cover. For more information, refer to the 
5-minute fix “Open Your Computer’s Case” in Chapter 1.
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5. On the rear of the new CD or DVD drive is a tiny plastic “jumper”
that must be placed onto the small metal pins in a specific way to
allow the drive to work side by side with the hard drives or other
CD/DVD drives in your system. On the top or rear of most CD or
DVD drives is a diagram or picture that shows where to place the
jumper to make the drive a “slave.” Although many CD or DVD
drives are already configured to be slaves, yours may not be. In that
case, follow the diagram or picture to make your new drive a slave.

6. Connect a data cable to the new CD or DVD drive. To do so, find the
ribbon cable connected to your hard drive, and then use the gray con-
nector in the middle of it to connect to your CD or DVD drive.

7. Connect a power cable to the new CD or DVD drive. Usually all
computers have extra power cables tucked away inside their cases.

8. If you want to hear audio from any CDs or DVDs played on your new
drive, you must connect an audio cable between the drive and the
CD-audio input slot on your sound card or motherboard. For more
details, refer to the owner’s manual or documents that came with your
computer.

9. Find an empty mounting bay inside the computer’s case, and then
slide the new CD or DVD drive into the bay and secure it (usually by
screwing the drive to the case).

10. If any wires or cables inside the computer were accidentally discon-
nected while installing the CD or DVD drive, reconnect them.

11. Close the case, and then return the base unit to your desk.

12. Reconnect the wires and cables into the back of the base unit, and
then plug the computer into an electrical outlet and turn it on.

13. Windows should automatically detect the new CD or DVD drive and
enable you to use it right away.

Replace Your Floppy Drive
Most people no longer use old-fashioned floppy disks, which is why many new
computers don’t include floppy drives. However, if you still have old files or pro-
grams from many years ago stored on floppies, you should consider keeping a
floppy drive in your computer. If your drive no longer works — or if you don’t
have one — you can buy a brand new one for a few dollars and install it yourself.

1. Purchase a floppy drive from a computer or electronics store or from
an Internet retailer such as Newegg.com (www.newegg.com). Often
an Internet store can save you quite a bit of money compared to its
brick-and-mortar counterparts.

2. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.
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3. Disconnect all wires and cables from the back of the computer’s base
unit, and then place the unit on a wooden floor or table. Do not
attempt to perform any hands-on computer work while standing or
sitting on a carpet or rug. Doing so can generate static electricity that
can travel from your body into the computer and damage or destroy
your hardware.

4. Remove the computer’s cover. For more information, refer to the 
5-minute fix “Open Your Computer’s Case” in Chapter 1.

5. Disconnect the data cable and power cable from your old floppy drive.

6. Remove the old floppy drive by unscrewing it from its mounting bay.
(Newer computers may use plastic clips or other items to secure it.) 

7. Connect the data cable and power cable to your new floppy drive.

8. Place the new drive into the empty floppy-drive mounting bay, and
then secure it with the screws or plastic clips.

9. If any wires or cables inside the computer were accidentally discon-
nected while installing the floppy drive, reconnect them.

10. Close the case, and then return the base unit to your desk.

11. Reconnect the wires and cables into the back of the base unit, and
then plug the computer into an electrical outlet and turn it on.

12. Windows should automatically detect the new floppy drive and enable
you to use it right away.

Add a Dial-Up Modem
If you use a dial-up Internet service such as AOL or Earthlink, you may be frus-
trated by unusually slow Web site connections or downloads that seem to take
forever. Before griping to your Internet provider, consider this: The problem
may be your modem. If your computer is quite old, it may not be equipped with
a 56k modem (which is the fastest speed available over traditional phone lines).
Fortunately, it is inexpensive and easy to install a new modem.

1. Purchase a dial-up modem from a computer or electronics store or
from an Internet retailer such as Newegg.com (www.newegg.com).
Often an Internet store can save you quite a bit of money compared to
its brick-and-mortar counterparts.

2. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

3. Disconnect all wires and cables from the back of the computer’s base
unit, and then place the unit on a wooden floor or table. Do not
attempt to perform any hands-on computer work while standing or
sitting on a carpet or rug. Doing so can generate static electricity that
can travel from your body into the computer and damage or destroy
your hardware.
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4. Remove the computer’s cover. For more information, refer to the 
5-minute fix “Open Your Computer’s Case” in Chapter 1.

5. Locate an empty PCI slot (see Figure 2-7), and then remove the slot’s
metal or plastic cover by unfastening the screw or plastic arm that
holds it in place.

Figure 2-7

6. Firmly but gently insert the modem into the empty PCI slot.

7. Secure the modem by fastening a screw (see Figure 2-8) or snapping
the plastic arm back into place.

8. If any wires or cables inside the computer were accidentally discon-
nected while installing the modem, reconnect them.

9. Close the case, and then return the base unit to your desk.

10. Reconnect the wires and cables into the back of the base unit, and
then plug the computer into an electrical outlet and turn it on.

11. After Windows detects the new modem, it searches for a “driver” to
finish the setup. If the correct driver isn’t found, you need to install it
by using the setup CD that came with the modem.
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Figure 2-8

Add a Network Card
To connect to a high-speed Internet service such as DSL
or cable, your computer must have a wired network card
(also called an Ethernet card) or a wireless network 
card (also called a Wi-Fi card).

1. Purchase an Ethernet or Wi-Fi card from a com-
puter or electronics store or from an Internet
retailer such as Newegg.com (www.newegg.com).
Often an Internet store can save you quite a bit 
of money compared to its brick-and-mortar 
counterparts.

2. Turn off your computer and unplug it from all
electrical outlets. This will prevent you from receiv-
ing a serious electrical shock and will protect the
computer from being damaged.

3. Disconnect all wires and cables from the back of the computer’s base
unit, and then place the unit on a wooden floor or table. Do not
attempt to perform any hands-on computer work while standing or
sitting on a carpet or rug. Doing so can generate static electricity that
can travel from your body into the computer and damage or destroy
your hardware.
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your dial-up Internet
service and sign up
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doesn’t offer broad-
band, you can still
access the Internet.
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4. Remove the computer’s cover. For more information, refer to the 
5-minute fix “Open Your Computer’s Case” found in Chapter 1.

5. Locate an empty PCI slot (see Figure 2-9), and then remove the slot’s
metal or plastic cover by unfastening the screw or plastic arm that
holds it in place.

Figure 2-9

6. Firmly but gently insert the network card into the empty PCI slot.

7. Secure the network card by fastening a screw (see Figure 2-10) or
snapping the plastic arm back into place.

8. If any wires or cables inside the computer were accidentally discon-
nected while installing the network card, reconnect them.

9. Close the case, and then return the base unit to your desk.

10. Reconnect the wires and cables into the back of the base unit, and
then plug the computer into an electrical outlet and turn it on.

11. After Windows detects the network card, it searches
for a “driver” to finish the setup. If the correct
driver isn’t found, you need to install it by using the
setup CD that came with the network card.
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Figure 2-10

Replace Your Video Card
A video card is the important piece of hardware that sends images from your
computer to your monitor. If the bulk of your computer activities involves the
use of programs such as Microsoft Word, Outlook, and Internet Explorer, you
don’t need a powerful video card. However, if you want to play the newest PC
video games that have cutting-edge graphics, you will need to upgrade to a fast
video card.

1. Find out what type of video card your computer uses (PCI, AGP, or
PCIe) by referring to the 5-minute fix “Determine the Video Card’s
Interface” in Chapter 1. Another way to find this information is to
visit www.powerleap.com and use its upgrade advisor to automatically
detect your system settings and tell you what type of video-card inter-
face you have.

2. Purchase a new video card from a computer or electronics store or
from an Internet retailer such as Newegg.com (www.newegg.com).
Often an Internet store can save you quite a bit of money compared to
its brick-and-mortar counterparts.

3. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

4. Disconnect all wires and cables from the back of the computer’s base
unit, and then place the unit on a wooden floor or table. Do not
attempt to perform any hands-on computer work while standing or
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sitting on a carpet or rug. Doing so can generate static electricity that
can travel from your body into the computer and damage or destroy
your hardware.

5. Remove the computer’s cover. For more information, refer to the 
5-minute fix “Open Your Computer’s Case” in Chapter 1.

6. Based on the type of interface used by your new video card, locate an
empty PCI slot, an empty AGP slot, or an empty PCIe slot. Remove
the slot’s metal or plastic cover by unfastening the screw or plastic
arm that holds it in place.

7. Firmly but gently insert the video card into the appropriate slot.

8. Secure the video card by fastening a screw (see Figure 2-11) or snap-
ping the plastic arm back into place.

Figure 2-11

9. If any wires or cables inside the computer were accidentally discon-
nected while installing the video card, reconnect them.

10. Close the case, and then return the base unit to your desk.

11. Reconnect the wires and cables into the back of the base unit, and
then plug the computer into an electrical outlet and turn it on.

12. After Windows detects the new video card, it searches for a “driver” to
finish the setup. Do not use the standard, default drivers that Windows
installs. The only way to enjoy the powerful features of your new video
card is to install the special drivers and software located on the setup
CD that came with it.
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Replace Your Sound Card
If you enjoy playing video games or watching DVD movies on your computer,
you should consider upgrading your sound card to one that has enhanced fea-
tures such as Dolby Digital 5.1 or 7.1 surround sound.

1. Purchase a new sound card from a computer or electronics store or
from an Internet retailer such as Newegg.com (www.newegg.com).
Often an Internet store can save you quite a bit of money compared to
its brick-and-mortar counterparts.

2. Turn off your computer and unplug it from all electrical outlets. This
will prevent you from receiving a serious electrical shock and will pro-
tect the computer from being damaged.

3. Disconnect all wires and cables from the back of the computer’s base
unit, and then place the unit on a wooden floor or table. Do not
attempt to perform any hands-on computer work while standing or
sitting on a carpet or rug. Doing so can generate static electricity that
can travel from your body into the computer and damage or destroy
your hardware.

4. Remove the computer’s cover. For more information, refer to the 
5-minute fix “Open Your Computer’s Case” found in Chapter 1.

5. Locate an empty PCI slot (see Figure 2-12), and then remove the
slot’s metal or plastic cover by unfastening the screw or plastic arm
that holds it in place.

Figure 2-12

42 Part I • The Nuts and Bolts of PCs

06_77989x ch02.qxp  11/10/05  6:50 PM  Page 42



6. Firmly but gently insert the sound card into the empty PCI slot.

7. Secure the sound card by fastening a screw (see Figure 2-13) or snap-
ping the plastic arm back into place.

Figure 2-13

8. If any wires or cables inside the computer were accidentally discon-
nected while installing the sound card, reconnect them.

9. Close the case, and then return the base unit to your desk.

10. Reconnect the wires and cables into the back of the base unit, and
then plug the computer into an electrical outlet and turn it on.

11. After Windows detects the new sound card, it searches for a “driver”
to finish the setup. Do not use the standard, default drivers that
Windows installs. The only way to enjoy the powerful features of your
new sound card is to install the special drivers and software located on
the setup CD that came with it.
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3
BUYING A 
NEW PC

Buying a computer is a lot like buying a car. Both
require you to research the numerous makes and 
models available and carefully select the features — and

price tag — that are right for you. Should you go with the hum-
ble, no-frills model? What about the turbocharged top-of-the-
line model with all the bells and whistles? Is it worth getting an
extended warranty? Questions like these can feel overwhelming
(and unending). Fortunately, you are not alone in this process.
Consider this chapter to be your digital chauffeur, here to help
you bypass the traffic jams of overcrowded computer stores
and arrive safely at a final decision.

If you already own a computer but are considering replacing it,
the first thing you should ask yourself is “Do I really need a
new one?” As discussed in Chapter 2, upgrading the broken or
outdated parts on a computer is a great way to save time and
money and to get the most out of your investment. However, it
is true that some PCs are so old or have so many problems 
that it is easier (and sometimes cheaper) to replace them with
new ones.

Here are the most common reasons for buying a new 
computer:

• Meeting the demands of modern software:
Many modern programs such as video games or
photo/video-editing software need a fast, powerful
computer in order to run properly.

• Eliminating high-tech headaches: Some com-
puters are so old or have so many problems that it is
simpler to get rid of them and start over with a
fresh, new system.

Pick the perfect PC

Do It Yourself
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• Upgrading can be difficult: Because so many people today lead
busy lives, they can’t afford to spend time learning how to take apart
and upgrade a computer.

• Having the latest and greatest: Sometimes it can be fun to have
the newest cutting-edge equipment and gadgets to play with.

Pick the Perfect PC
If you have carefully considered the great debate about upgrading vs. buying and
have decided that a new PC is the best choice for you, your next course of
action is to pick the type of computer you need, select a style (desktop or lap-
top), and consider which additional features you want.

Computer Types
The most important factor to consider when buying a new computer is the activ-
ities you anticipate doing on it. How the computer will be used and the number
of people using it will determine how many problems it develops, its condition
one year from now, its overall lifespan, and more. Here are the four common
types of computers. Choose the one that most accurately describes your needs:

• Light general use: Used by one to three people
for a few hours each day. Activities include typing
documents, sending and receiving e-mail, brows-
ing the Internet, and playing older video games
that do not have cutting-edge graphics.

• Heavy general use: Used by more than three
people or used for many hours each day. Activities
include typing documents, sending and receiving
e-mail, browsing the Internet, and playing video
games that have medium-level graphics.

• Gaming: Performs all of the activities of a heavy
general-use computer and users play video games
that have demanding, cutting-edge graphics.

• High performance: Meets all the criteria for a
gaming computer plus has extra top-of-the-line
hardware to handle demanding activities such as
using video-editing programs or other heavy-duty,
high-performance software.

Desktop vs. Laptop
After deciding what type of computer suits your needs,
you must choose its style: desktop or laptop.
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about how much your
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browsing the Internet,
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you should consider
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Desktop
As shown in Figure 3-1, a desktop PC is the standard style of computer used in
most homes and offices. Here are the advantages and disadvantages of buying a
desktop:

• Low cost: Most desktop PCs cost under $1,000, and some can be
purchased for as little as $300.

• Versatile: Can be used for all types of activities, including light gen-
eral use, heavy general use, gaming, and high performance.

• Upgradeable: Probably the best thing about desktop PCs is their
ability to be customized and upgraded. If a part breaks down, it can
be easily replaced. If you want to add extra hardware to play cutting-
edge video games or perform other demanding tasks, that too can be
easily done.

• Stationary: Unlike a laptop computer, a desktop PC has to remain
in one location at all times.

Figure 3-1

Laptop
As shown in Figure 3-2, a laptop (also called a notebook computer) is a small,
portable computer that is becoming increasingly popular in our on-the-go world.
Also, many educational institutions such as high schools and colleges are begin-
ning to require their students to use laptops in the classroom. Here are the
advantages and disadvantages of buying a laptop:
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Figure 3-2

• Mobile: The freedom to take their computer
wherever they go is the number-one reason most
laptop users give when explaining why they
bought one. However, the downside is that if the
laptop is accidentally left behind in a cab, train, or
subway, or if it is stolen, all of your computer files
will be lost forever (and potentially used by a
criminal to commit identity theft).

• Higher cost: An average laptop with middle-of-
the-road features often costs more than $1,000.
A high-end, powerful laptop often costs $2,000 
or more.
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Purchasing a laptop
doesn’t mean you
can’t use it at your
home or office in the
same way you would
use a desktop. Special
“base stations” allow
you to connect a lap-
top to a normal desk-
top monitor, and
nearly all laptops allow
you to connect a regu-
lar, full-sized keyboard
and mouse to them. 
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• Less versatile: The average laptop is limited to activities that fall under
the light general-use category. However, expensive top-of-the-line lap-
tops often have just as much power as most desktop PCs.

• Limited upgrades: A laptop cannot be opened to have its internal
components replaced or upgraded. Instead, you have to add external
upgrades such as cards that fit into the special slots on the side of the
laptop, or external devices such as a hard drive or rewritable DVD
drive that connects to the laptop’s USB or FireWire ports.

Features
Once you have selected a computer type and chosen a style, your next step is to
figure out which features you want. Here is a list of the four computer types and
the hardware they typically offer:

Light general use
• Slower processor (CPU): Up to 2.4 GHz

• Limited amount of system memory (RAM): Up to 256 MB

• Smaller hard drive: Between 40 and 80GB

Heavy general use
• Medium-speed processor (CPU): Approximately 2.8 GHz

• Average amount of system memory (RAM): Between 256 and
512MB

• Large hard drive: 80 GB or more

Gaming
• Fast processor (CPU): 3.2 GHz or more 

• Large amount of system memory (RAM): Minimum of 512MB

• Large hard drive: 80GB or more

• High-end speakers with a subwoofer or a complete surround-sound
system

• Powerful video card containing more than 128MB of video memory

High performance
• Fast processor (CPU): 3.2 GHz or more

• Large amount of system memory (RAM): Minimum of 512MB 

• Extra-large hard drive: Minimum of 100GB

• Recordable or rewritable DVD drive
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Warranty
Have you noticed that when you buy a piece of equipment from a computer or
electronics store, the salespeople immediately pounce on you and ask you to buy
an extended warranty or service plan? Although that approach is extremely
annoying, it doesn’t mean that warranties should be avoided. Usually, it doesn’t
make sense to buy a warranty for an inexpensive product, but a warranty might
be a wise decision for purchases that cost $1,000 or more. Before you buy any
warranty, you should always examine its features such as the length of coverage
and the things it won’t cover (which are usually listed in the fine print, so take
the time to read it). Here are several things a good service plan should include:

• No lemon policy: If the product needs a certain number of repairs
within a specified time limit, you will receive a new version of that
product (or its equivalent). For example, if your laptop has to be
repaired more than three times in one year, most warranties will
replace that laptop with a new one.

• Battery coverage: If the product’s battery stops working properly, it
will be repaired or replaced.

• Power-surge protection: If the product is damaged as a result of a
power surge through your electrical outlets, it will be repaired or
replaced. This can be quite valuable if you live or work in an area that
has unreliable electricity. But be warned: Some warranties specifically
indicate that they do not cover damage caused by power surges enter-
ing a computer through other sources such as telephone wires con-
nected to the computer’s dial-up modem.

• Renewable: When your original warranty expires, you can renew or
extend it for a specified amount of time.

• Transferable: The warranty stays with the product, not with the per-
son who bought it. That means if you sell or donate your product to
someone else, the warranty can still be used by that person.
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PART II
ENHANCING YOUR 
PC EXPERIENCE 
The number of helpful or fun activities you can do with a PC is simply stagger-
ing: paying bills over the Internet; printing digital photos; scanning old pictures
to create long-lasting archival copies; editing home movies, listening to MP3
music files; and so much more. If you are interested in using your computer for
more than playing Solitaire, this section of the book will show you numerous
ways to make your high-tech experience more rewarding.
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4
CONNECTING TO 
THE INTERNET

In the blink of an eye, the Internet — also referred to as the
“Web” — has gone from novelty to necessity, ingraining
itself in our culture to such an extent that people don’t just

use it — they depend on it. For some, life without the Web is
inconceivable. Typical daily tasks performed by Internet users
include:

• Using e-mail to stay in contact with family, friends,
and business associates

• Saving money by shopping at e-merchants (Internet
stores)

• Managing bank accounts

• Paying bills directly from a checking account

• Doing research for school and work-related projects

• Reading the latest news headlines from the
Associated Press or CNN

• Checking sports scores and movie show times

• Downloading “try-it-before-you-buy-it” versions of
software

• Purchasing legal digital copies of music CDs and
individual songs

• Viewing streaming videos of concerts, sporting
events, and breaking news

Types of Internet Service
If you haven’t yet taken a dip in the vast digital ocean known as
the Internet, what are you waiting for? Jump in — the water is
great.The first step you must take is to decide what type of
Internet service fits your needs and your budget.The three types
of Internet used in most homes and small businesses are dial-up,
DSL (which stands for digital subscriber line), and cable.

Types of Internet
service

Sign up for Internet
service

Restore a dial-up
connection

Troubleshoot a slow
dial-up connection 

Access the Internet
from a wired network 

Solve problems
connecting to a wired
network 

Access the Internet
from a wireless
network 

Solve problems
connecting to a
wireless network 

Repair a broken
Internet connection

Do It Yourself
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Dial-up Internet service
• Uses regular telephone lines

• Requires a dial-up modem (which most 
computers have)

• Is available in any home or office that has a 
working telephone line

• Has a very slow connection speed (up to 56K)

• Is inexpensive, costing between $10 and $22 per month (depending
on whether your plan has a limited number of hours per month or
has unlimited usage)

DSL Internet service
• Uses regular telephone lines

• Requires a USB or Ethernet port on your PC

• Is available in many larger communities but is not always offered in
smaller ones

• Has a medium connection speed (between 300K and 800K, depend-
ing on how far away your home or office is from a DSL transmitter)

• Is reasonably priced, costing between $15 and $30 per month

Cable Internet service
• Uses cable lines to transmit signals (the same lines that provide 

cable TV)

• Requires a USB or Ethernet port on your PC

• Is not available in every community (but is usually offered in more
areas than DSL)

• Has a fast connection speed (up to 1,500K)

• Is more expensive, costing between $45 and $50 per month

Sign Up for Internet Service
After you have decided what type of Internet access you prefer, you need to sign
up for an account with an Internet service provider (ISP). For dial-up, this usu-
ally can be done without professional help. For DSL and cable, it either requires
professional installation or a do-it-yourself kit offered by the Internet provider.

Dial-up Internet Access
Numerous local and national companies offer dial-up Internet services. Some of
the more well-known names include AOL, MSN, Earthlink, and NetZero. When
selecting a dial-up provider, consider these features:
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• Amount of access numbers: Make sure the provider offers several
local access numbers near your home or office (because if you don’t
dial a local number, you could be charged for making expensive long-
distance calls every time you connect to the Internet). Also, choose a
provider that offers more than one local access number. That way, if
one number is busy, you can always call another.

• Price: Compare the monthly fees charged by each provider for
unlimited Internet access.

• Number of e-mail accounts: Most dial-up providers allow you to
have several e-mail accounts — enough for each person in your house-
hold or small business.

• Web site space: Many dial-up providers give you a specific amount
of space to create your own Web site that can be accessed by anyone
who uses the Internet. This is particularly useful if you run a small or
home-based business.

When you have chosen a dial-up provider, follow these steps to set up an
account:

1. If you have decided to go with a national dial-up company such as
AOL or MSN, you will need to obtain a CD containing their installa-
tion software. Usually these CDs can be picked up free of charge at
most computer or electronics stores. If no stores in your area carry
them, ask your neighbors if they have any. If you still have no luck, use
a computer at your office or at a neighbor’s house to visit the dial-up
provider’s Web site and sign up for service as well as download the
installation software.

2. If you have decided to go with a local dial-up company, you must call
it to inquire about how to sign up. Usually the company sends a tech-
nician to perform the setup or mails you an installation CD.

3. Connect your modem to a telephone jack by plugging one end of a
telephone cord into your modem and then plugging the other end into
a telephone jack on the wall of your home or office.

4. Install the dial-up software and follow the onscreen instructions.

DSL Internet Service
Because DSL Internet services use a traditional telephone line, they are usually
offered by your local phone company. Here is a general overview of the steps
involved in setting up DSL:

1. Scan your local telephone directory to determine which phone compa-
nies in your area offer DSL. If you have more than one choice, compare
their prices, features, and customer service before making a decision.

2. After you have picked a provider, sign up for a DSL account. Most
DSL providers can install the necessary equipment — for a fee. To save
money, ask for a self-installation kit. Typically, this kit contains a DSL
modem, Ethernet cables, phone-line filters, an installation CD, and
detailed instructions.
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Cable Internet Service
As its name indicates, cable Internet services are offered by a local cable com-
pany (the same one that provides your local cable TV channels). Many commu-
nities have only a single cable provider, but a lucky few have more than one
(which helps to drive down the cost of the cable services). Here is a general
overview of the steps involved in setting up cable Internet:

1. Scan your local telephone directory to determine which companies 
in your area offer cable Internet. If you have more than one choice,
compare their prices, features, and customer service before making a
decision.

2. After you have picked a provider, sign up for an Internet account.
Most cable providers can install the necessary equipment — for a fee.
To save money, ask for a self-installation kit. Typically, this kit contains
a cable modem, Ethernet cables, an installation CD, and detailed
instructions.

Restore a Dial-up Connection
If your modem suddenly cannot access your dial-up Internet service, try these
fixes:

• Check for a dial tone: Use a standard telephone to call the local
access number that your modem is trying to dial. Within a few sec-
onds you should hear a digital tone. If you don’t hear it, either you
called the wrong number or your Internet provider’s equipment is not
working properly. If you hear a busy signal, try using your modem to
dial an alternate local access number.

• Check your modem’s status: If you are certain that the local access
number is working properly, you should determine whether your
modem has malfunctioned. See the section that follows for details.

For Windows XP and Windows 2000
1. Click the Start button in the lower-left corner of Windows.

2. Click the Control Panel. (If you don’t see this option, your start menu
is in Classic mode. In that case, click Settings, and then select the
Control Panel.)

3. If the Control Panel is in Category view, click the Performance and
Maintenance category, and then click the System icon. If the Control
Panel is in Classic view, simply double-click the System icon.

4. A window opens. Click the Hardware tab.

5. Click the Device Manager button.

6. The Device Manager window opens. Click the plus sign (+) next to
the Modems category.

7. Double-click the name of your modem.
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8. Another window opens. On the General tab, look for the Device status
heading. There you should see a message indicating whether or not
your modem is working properly.

9. If the message says your modem is not working properly or has an
error, try uninstalling the software that came with your modem. Next,
reinstall that same software, and then try using the modem again.

10. If the message says your modem is operating correctly, check to see if
your connection problems have occurred because the telephone cord
is loose or unplugged from either the modem or the phone jack. Also,
check for cuts, splits, or large dents on the phone cord. If it is dam-
aged, replace it, and then try your Internet connection again.

11. If your connection problems continue, replace your modem.

For Windows 98 and Windows ME
1. Right-click the My Computer icon on your desktop.

2. Select Properties.

3. Click the Device Manager tab.

4. The Device Manager window opens. Click the plus sign (+) next to
the Modem category.

5. Double-click the name of your modem.

6. Another window opens. On the General tab, look for the Device status
heading. There you should see a message indicating whether or not
your modem is working properly.

7. If the message says your modem is not working properly or has an
error, try uninstalling the software that came with your modem. Next,
reinstall that same software, and then try using the modem again.

8. If the message says your modem is operating correctly, check to see if
your connection problems have occurred because the telephone cord
is loose or unplugged from either the modem or the phone jack. Also,
check for cuts, splits, or large dents on the phone cord. If it is dam-
aged, replace it, and then try your Internet connection again.

9. If your connection problems continue, replace your modem.

Troubleshoot a Slow Dial-up Connection
If your dial-up Internet feels unusually slow, try one of
these remedies:

1. Try dialing an alternate access number. It is possi-
ble that your current access number has slowed
because a large number of people are using it
simultaneously.
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2. Inspect your phone cord for cuts, splits, or large
dents. If the cord is damaged, replace it, and then
try your Internet connection again.

3. If your current phone cord is quite long, replace it
with one that is as short as possible (because
shorter phone cords often provide faster dial-up
connections).

4. If you hear annoying static while making phone
calls, there is a good chance the static is also inter-
fering with the signals your dial-up modem sends
and receives. Ask your phone company to repair
the line and eliminate the static.

Access the Internet from a Wired
Network
If your PC has a network card (also called an Ethernet
card), you can use it to connect to a wired computer net-
work that has been set up in your home or office or in a
place like a hotel room.

Note
If you are connecting to a public network (such as those
found in hotel rooms, coffee shops, and so on), you don’t
have to dial in to the Internet provider you use back home. 

1. Obtain an Ethernet cable (often called a “CAT5”
cable) long enough to reach between your com-
puter and the Ethernet jack located on a nearby wired/wireless router
or on a nearby wall (such as in your office, hotel room, and so forth).

2. Connect one end of the Ethernet cable to the Ethernet port on your
PC (see Figure 4-1), and then connect the other end to the Ethernet
jack on the router or wall (see Figure 4-2).

3. If you are using Windows XP, a message should appear near the bot-
tom of your screen indicating that a network connection has been
made.
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Figure 4-1

Figure 4-2
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Solve Problems Connecting to a Wired Network
If your computer is having difficulty connecting to a wired network, you should
find out whether your network card has malfunctioned. To do so, follow these
steps:

1. Click the Start button in the lower-left corner of Windows.

2. Click the Control Panel. (If you don’t see this option, your Start menu
is in classic mode. In that case, click Settings, and then select the
Control Panel.)

3. If the Control Panel is in category view, click the Performance and
Maintenance category, and then click the System icon. If the Control
Panel is in classic view, simply double-click the System icon.

4. A window opens. Click the Hardware tab.

5. Click the Device Manager button.

6. The Device Manager window opens. Click the plus sign (+) next to
the Network Adapters category.

7. Double-click the name of your network card.

8. Another window opens. On the General tab, look for the Device sta-
tus heading. There you should see a message indicating whether or
not your network card is working properly.

9. If the message says your network card is operating correctly, check to
see if your connection problems have occurred because your Ethernet
cable is loose or unplugged from either the network card or the
Ethernet jack. Also, check for cuts, splits, or large dents on the
Ethernet cable. If it is damaged, replace it, and then try your Internet
connection again.

10. If the message says your network card is not working properly or has
an error, return to the Device Manager’s main window.

11. Right-click the name of your network card, and then select Uninstall.
If a message warns you that you are about to uninstall the card, click
OK. This will cause your card to be uninstalled from Windows.

12. Shut down your computer and restart it. When Windows loads, it
detects your network card and goes through the process of reinstalling
it. If Windows cannot find the proper “drivers” to complete the setup
of your card, you may have to use the installation CD that came with
the card or with your computer.

13. If your connection problems continue, replace your network card.

Access the Internet from a Wireless Network 
If your computer is equipped with a wireless network card (also called a Wi-Fi
card), you can use it to access wireless networks at your home, office, or in a
public place such as a coffee shop or bookstore.
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Note
These steps apply to Windows XP only.

1. Right-click the wireless icon in the lower-right corner of Windows.

2. Click on View Available Wireless Networks. If you don’t see any available
wireless networks, go to Step 6. Otherwise, proceed to the next step.

3. Click the wireless network you want to access (see Figure 4-3).

Figure 4-3

4. Click Connect.

5. If your version of Windows XP has Service Pack 2 installed and you
are trying to access an unsecured network, you will probably have to
click the Allow me to connect to the selected wireless network even
though it is not secure option. On the other hand, if the wireless net-
work you are connecting to is secured, you will be asked to enter an
encryption key or password.

6. If you don’t see any available wireless networks listed in Windows,
make sure your wireless router is plugged into an electrical outlet and
is working properly.

Solve Problems Connecting to a Wireless Network
If your computer is having problems accessing wireless networks, follow these
fixes:

Note
These steps apply to Windows XP only.

1. Move closer to the wireless router. To have a strong connection you
should be within 100 feet of the router.

2. Make sure the wireless router is plugged into an electrical outlet and
appears to be turned on (as indicated by the solid or blinking lights on
the front of the router).
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3. Reboot your wireless router by unplugging its power cord from the
electrical outlet, waiting 15 seconds and then plugging it back in.

4. Reboot your wireless card by disabling it and then re-enabling it
within Windows. Here’s how:

a. Click the Start button in the lower-left corner of Windows.

b. Click the Control Panel. If you don’t see this option, your start
menu is in classic mode. In that case, click Settings, and then
select the Control Panel.

c. If the Control Panel is in category view, click the Network and
Internet Connections category, and then click the Network
Connections icon. If the Control Panel is in classic view, simply
double-click the Network Connections icon.

d. Double-click the icon for your wireless connection (see 
Figure 4-4).

Figure 4-4

e. Wait a minute to see if a message pops up to say that the wire-
less card is connected to the network.

5. If the message indicates that no network connection is available,
then you will have to manually set the “SSID” in the wireless card.
Here’s how:

a. Double-click the wireless icon in the lower-right corner of
Windows. If this icon is not available, click the Start button in
the lower-left corner of Windows and click All Programs to dis-
play a list of the programs on your computer. Next, click the
name of the manufacturer’s configuration utility for your 
wireless card.

b. After the configuration utility opens, find the section containing
your wireless settings. Often, it is located on a Configuration tab.

c. Type the name (the SSID) of the wireless network you want to
access. If you do not own that network, you will need to get the
SSID from the proper owner. For example, if you are trying to
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use a wireless network in a hotel, you will have to call the front
desk and ask for its SSID.

d. If the wireless network has encryption enabled, select the
encryption type and enter the encryption key or password.

Repair a Broken Internet Connection
A common problem experienced by Windows users is a malfunctioning Internet
connection.There are several reasons why this occurs—and just as many remedies.

Reboot Your Modem, Your Router, or Both
Sometimes a malfunctioning Internet connection can be caused by an error in
computer hardware such as a cable/DSL modem or a router. To correct any
problems with these devices, you must reboot them.

1. Shut down your computer.

2. Unplug the power cord from the back of your modem and router. An
alternate method is to use the tip of a pencil to push the small “reset”
button located at the rear of the modem or router.

3. The lights on the front of your modem or router will go dark. Wait 30
seconds, and then plug the power cord back in. This will cause the
lights on the front of the modem or router to begin blinking rapidly in
a particular pattern. Wait for an additional 30 seconds, and then
restart your computer.

Temporarily Disable Your Software Firewall
Sometimes a software firewall such as ZoneAlarm or Norton Personal Firewall
can experience a digital “hiccup” that interferes with the way it monitors and
manages your Internet connection. Common symptoms of this problem include
a suddenly slow Internet connection, Web pages that stall or are unresponsive, or
the complete inability to access the Internet. To determine if your firewall is the
cause of your problems, you can temporarily disable it.

1. Right-click the icon for your firewall, which is usually located in the
lower-right corner of Windows near the clock.

2. Select the option to Close or Disable or Shut Down.

3. Try connecting to the Internet. If you are successful, restart your fire-
wall by right-clicking its icon near the Windows clock and selecting
Enable or Restore. If the firewall’s icon is not there, then you must
manually restart the program by doing the following:

a. Click the Start button in the lower-left corner of Windows.

b. Click on All Programs.

c. Select the folder containing the name of your firewall software.
For example, if you use ZoneAlarm, select the Zone Labs folder.

d. Click the shortcut to launch the program.
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4. If re-enabling your firewall causes your Internet connection to mal-
function again, it is likely that your firewall has become corrupted and
must be reinstalled by following the steps that follow. This requires its
original installation CD-ROM or its digital installer and license key.

a. Click the Start button in the lower-left corner of Windows.

b. Click the Control Panel. (If you don’t see this option, your Start
menu is in classic mode. In that case, click Settings, and then
select the Control Panel.) 

c. Double-click Add or Remove Programs.

d. A window opens. Scroll down the list until you see the name of
your firewall.

e. Click the name of your firewall, and then click the Remove but-
ton on its right. If a message pops up and asks you if you want
to uninstall the program, click Yes.

f. After the firewall has been successfully removed, reinstall it by
using its CD-ROM or installer program.

Automatically Obtain an IP Address
Another potential cause of your Internet woes may be that Windows is using an
incorrect IP address. To configure Windows to automatically obtain a valid IP
address, do the following:

1. Click the Start button in the lower-left corner of Windows.

2. Click the Control Panel. If you don’t see this option, your Start menu
is in classic mode. In that case, click Settings, and then select the
Control Panel.

3. If the Control Panel is in category view, click the Network and Internet
Connections category, and then click the Network Connections icon. If
the Control Panel is in classic view, simply double-click the Network
Connections icon.

4. Double-click the icon for your network connection.

5. A window opens. Under the tab labeled General, click the Properties
button.

6. Another window opens. Click once on the words Internet Protocol
(TCP/IP). Be careful not to accidentally remove the checkmark from
the box.

7. Click the Properties button.

8. A new window opens. Click the Obtain an IP address automatically
option (see Figure 4-5).
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Figure 4-5

9. Click OK to save your changes.

Set a Permanent IP Address
Some Internet providers require their customers to use a static, unchanging IP
address. If this is the case with your provider and you haven’t configured
Windows to use only one IP address, follow these steps:

1. Click the Start button in the lower-left corner of Windows.

2. Click the Control Panel. If you don’t see this option, then your Start
menu is in classic mode. In that case, click Settings, and then select
the Control Panel.

3. If the Control Panel is in category view, click the Network and Internet
Connections category, and then click the Network Connections icon. If
the Control Panel is in classic view, simply double-click the Network
Connections icon.

4. Double-click the icon for your network connection.

5. A window opens. Under the tab labeled General, click the Properties
button.

6. Another window opens. Click once on the words Internet Protocol
(TCP/IP). Be careful not to remove the checkmark from the box.

7. Click the Properties button.

8. A new window opens. Click the Use the following IP address option
(see Figure 4-6).
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Figure 4-6

9. In the IP address box, type the numbers for the IP address given to
you by your Internet provider. For example, if you were told that your
permanent IP address is 192.168.1.5, you type those numbers into
the box.

10. In the Subnet mask box, type the numbers for the subnet mask given
to you by your Internet provider (often those numbers will be
255.255.255.0).

11. In the Default gateway box, type the numbers for the default gateway
given to you by your Internet provider.

12. Click OK to save your changes.You may need to reboot your com-
puter before the changes can be applied.
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5
INSTALLING
PERIPHERALS

Half the fun of using a computer comes from its acces-
sories (usually referred to as “peripherals”) such as
printers, scanners, and digital cameras. This chapter

explains how to install and set up common peripherals and
provides fixes for problems you might run into.

Use Newer Gadgets on Older PCs
To make a modern peripheral work on an outdated version of
Windows such as 98 or ME, you need to install small pieces of
software called “drivers” that tell Windows how to interact with
the device. Usually all peripherals come with an installation
CD-ROM containing the proper drivers, but if you have lost
this CD or never received it (which often happens when you
buy a used peripheral from a place like eBay), you will need to
download the drivers.

1. Open your Web browser and visit the manufacturer’s
Web site.

2. Find the section of the site either labeled Support or
Downloads, and search for information about drivers.

3. You probably will need to know the make and model
of your product (so you may need to look on its
exterior for that information).

4. Find the drivers that are designed to work with your
version of Windows. Usually, the downloads will
come in the form of an executable program. If so,
download the executable to a folder on your com-
puter that you can easily locate.

5. Double-click the executable to begin the installation
of the drivers.

6. Try connecting your product again.

Use newer gadgets
on older PCs

Add a surge
protector

Add a battery backup 

Add a USB hub

Replace your
speakers 

Replace your monitor

Replace your mouse

Clean your mouse

Replace your
keyboard

Connect a printer

Configure printer
preferences 

Connect a digital
camera

Connect a camcorder

Connect a video game
controller 

Connect a scanner

Do It Yourself
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Add a Surge Protector
Did you know it is dangerous to plug your computer or other gadgets directly
into an electrical outlet? A thunderstorm or power surge can send intense bursts
of electricity racing through the power lines in your home or office. These bursts
can travel into your computer and fry it — or even worse, they can cause your
computer to catch fire, which in turn could ignite the rest of your building. To
prevent this from happening, use a device known as a surge protector.

Note
Not all surge protectors provide the same protection. Generally, the more expensive
one is, the better protection its offers.

1. Properly shut down your PC and other equipment.

2. Unplug your PC and related equipment from the power strip or elec-
trical outlet to which they are currently connected.

3. Plug your new surge protector into an available electrical outlet.

4. Plug your PC and other equipment into the outlets on the surge pro-
tector (see Figure 5-1).

Figure 5-1

5. Most surge protectors have an On/Off switch. Make sure this switch is
set to the On position (which usually causes a light to turn on).

6. Turn on your computer and peripherals and use them as you normally
would.
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Add a Battery Backup
A battery backup (also known as an uninterruptible power supply) is a device
that not only serves as a surge protector, but also has a large battery that pro-
vides emergency electricity during a power outage or brown-out. Originally, bat-
tery backups were designed only to provide a few minutes of power — just
enough to save your open computer files and safely shut down your computer —
but modern ones can often supply an hour or more.

1. Properly shut down your PC and other equipment.

2. Unplug your PC and related equipment from the power strip or elec-
trical outlet to which they are currently connected.

3. Plug your new battery backup into an available electrical outlet.

4. Plug your PC and other equipment into the battery backup’s outlets.
Keep in mind that most battery backups have only a few outlets that
connect to the backup system, while the others are just regular or
surge-protected outlets.

5. Nearly every battery backup has an On/Off switch. Make sure this switch
is set to the On position (which usually causes a light to turn on).

Add a USB Hub
If you have a lot of USB devices to connect to your computer but not enough
USB ports, you can add more by installing a USB hub. Basically a hub is a small
box that plugs into a single USB port on your computer. On the hub are usually
between two and six USB ports. Instead of reaching around the back of your
computer to plug in a USB device such as a digital camera, you can simply plug
that device directly into the hub. Here’s how to install a hub:

Note
If your computer supports high-speed USB 2.0 devices, be sure to buy a hub that
also handles USB 2.0. 

1. Most USB hubs have a USB cable built into them. If that is the case
with your hub, connect the cable to an available USB port on your
computer. If your hub has a detachable USB cable, plug one end 
into the hub and the other end into an available USB port on your
computer.

2. Most USB hubs do not have a separate power cord, because they
receive electricity through the USB cable. However, if your hub has a
separate power cord, connect the appropriate end into the hub and
the other end into an electrical outlet.

3. Plug your USB devices into the hub (see Figure 5-2).
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Figure 5-2

Replace Your Speakers
If you enjoy using your computer to play video games or watch DVD movies,
you should consider replacing your old, simple speakers with a state-of-the-art
set. Most modern computer speakers come with a subwoofer to provide boom-
ing bass, and you can even buy an entire surround-sound system designed to
work perfectly with your computer. To install new speakers, follow these steps:

1. Shut down your PC.

2. If your sound system has a subwoofer, do the following:

a. Plug your speakers into the subwoofer.

b. Plug the subwoofer into the audio-output connector on your
computer.

c. Connect one end of the power cord into the subwoofer and the
other end into an electrical outlet.

3. If your sound system does not have a subwoofer,
do the following:

a. Plug one of the speakers into the main
speaker.

b. Plug the main speaker into the audio-output
connector on your computer.

c. Connect one end of the power cord into the
main speaker and the other end into an electrical outlet.
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Replace Your Monitor
If your computer monitor is too small or doesn’t produce a bright, sharp picture
anymore, the best thing to do is replace it.

1. Shut down your computer and monitor.

2. Disconnect the monitor’s video cable from the computer, and then
unplug the monitor’s power cable from the electrical outlet.

3. Move your old monitor out of the way, and then move the new one
into place.

4. Connect your new monitor’s video cable to your computer’s video card.

5. Connect one end of the power cord to the new monitor, and then
plug the other end into an electrical outlet.

6. Turn on your computer and your new monitor.

Clean Your Mouse
If you are using an old-fashioned computer mouse — the kind with a movable
ball — you might notice that sometimes the mouse’s onscreen cursor doesn’t
immediately respond to the movements of your hand. Usually the cause is dirt,
hair, or other debris that has accumulated inside the mouse (see Figure 5-3).
Fortunately, there is an easy solution: Clean your mouse.

1. Shut down your computer.

2. Unplug the mouse from the back of your computer.

3. Remove the cover on the bottom of the mouse. Usually this is done by
pushing down and turning the cover in the direction indicated by the
arrows etched on it.

4. When the cover opens, you will see a small rubber ball. Set the ball
aside, but be careful not to lose it.

5. You will see three rollers inside the mouse. Use the tip of a pen,
tweezers, or your fingernails to remove the debris from the rollers.

6. Clean your mouse ball with a warm, damp cloth. Make sure the ball is
dry before proceeding to the next step.

7. Insert the ball into the mouse (see Figure 5-4), and then reattach the
cover.

8. Plug the mouse back into your computer, and then turn on your 
computer.
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Figure 5-3

Figure 5-4
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Replace Your Mouse
Instead of using an old-fashioned mouse that needs to be cleaned every few
months, consider replacing it with an optical mouse that doesn’t use a ball.
Instead, it uses a laser beam, which means the movements of your hand will be
more accurately recognized and displayed on screen. Here’s how to install a new
mouse:

Note
Most modern mice use USB connectors. If your computer doesn’t have any USB
ports, you will need to use a “PS/2 to USB” adapter. 

1. If your new mouse is designed to use a USB interface, you can simply
plug it into your computer while the computer is running. If your new
mouse does not use USB, you must turn off your computer before
connecting the mouse.

2. Unplug your current mouse.

3. Plug your new mouse into your computer’s PS/2 or USB port.

4. Turn on your computer (if necessary) and start using your new
mouse.

5. If your mouse came with a CD-ROM containing software that will
enhance its features and performance, install that software.

Replace Your Keyboard
The keyboards that come with most computers tend to be very simple, lacking
advanced features. If you want to replace your old keyboard with one that has
multimedia buttons, shortcut keys, and many other enhancements, do the 
following:

Note
Most modern keyboards use USB connectors. If your computer doesn’t have any
USB ports, you will need to use a “PS/2 to USB” adapter. 

1. If your new keyboard is designed to use a USB interface, you can sim-
ply plug it into your computer while the computer is running. If your
new keyboard does not use USB, you must turn off your computer
before connecting the keyboard.

2. Unplug your current keyboard.

3. Plug your new keyboard into your computer’s PS/2 or USB port (see
Figure 5-5).
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Figure 5-5

4. Turn on your computer (if necessary) and start using your new 
keyboard.

5. If your new keyboard has special features such as programmable 
buttons or a built-in video game controller, you will probably need to
install special software by using the CD-ROM that came with the 
keyboard.

Connect a Printer
Almost all printers available today use USB interfaces. To connect a USB
printer to your computer, follow these steps:

1. Most printers come with a USB cable (see Figure 5-6). Connect one
end of the cable to the USB port on the printer, and then connect the
other end of the cable to a USB port on your computer.

2. If the printer’s power cord is not permanently attached, plug one end
of it into the printer and plug the other end into an electrical outlet.

3. Windows should detect the new scanner and search for “drivers” to
complete the installation. If Windows cannot find them, you will have
to install the proper drivers by using the installation CD that came
with the scanner or by downloading them from the manufacturer’s
Web site.

4. Use the CD that came with your printer to install the special software
that will enable the printer to function properly.
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Figure 5-6

Configure Printer Preferences
After you have installed a printer, you should configure its settings. Doing so can
make your ink cartridges last longer, speed up printing time, and produce nicer-
looking prints.

For Windows XP Home/Pro and Windows 2000
1. Click the Start button in the lower-left corner of Windows.

2. Click the Control Panel. If you don’t see this option, your Start menu
is in classic mode. In that case, click Settings, and then select the
Control Panel.

3. If the Control Panel is in category view, click the Printers and Other
Hardware category, and then click the Printers and Faxes icon. If the
Control Panel is in classic view, simply double-click the Printers and
Faxes icon.

4. Right-click the printer you want to configure.

5. Click Printer Preferences.

6. Printer preferences differ based on the computer and printer you are
using, so you need to explore the available settings by clicking the var-
ious tabs and selecting or deselecting the numerous options. For
example, you can change the printer quality (see Figure 5-7), the print
color, the orientation (either “landscape” or “portrait” as shown in
Figure 5-8), and the print order (front to back or back to front).
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Figure 5-7

Figure 5-8

For Windows 98 and ME
1. Click the Start button in the lower-left corner of

Windows.

2. Click Settings.

3. Click Printers.

4. Right-click the printer you want to configure.

5. Click on Printer Preferences.
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6. Printer preferences differ based on the computer and printer you are
using, so you need to explore the available settings by clicking the var-
ious tabs and selecting or deselecting the numerous options. For
example, you can change the print quality (see Figure 5-9), the print
color, the orientation (either “landscape” or “portrait” as shown in
Figure 5-10), and the print order (front to back or back to front).

Figure 5-9

Figure 5-10

Connect a Digital Camera
One of the best things about using a digital camera is the ease with which you
can connect it to your computer, transfer your photos to your hard drive, and
then e-mail them to your friends and family — without having to get them
processed by a photo lab. To connect a digital camera to your PC, follow these
steps:
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1. Most digital cameras come with a USB cable. Connect one end of the
cable to the USB port on the digital camera, and then connect the
other end of the cable to a USB port on your computer.

2. If you are using Windows XP, you will likely see a window that tells
you a device has been connected and asks what program you would
like to launch. To use this Widows utility to view and copy your pic-
tures to your PC, select Microsoft Scanner and Camera Wizard, and
then click OK (see Figure 5-11).

Figure 5-11

3. If you are using Windows 98, the Found New Hardware Wizard will
likely pop up and ask you to install the drivers from the setup CD.
Also, you will need to install the software included on that same CD
in order to transfer photos to and from the camera.

Connect a Camcorder
If you own a digital camcorder that you use to make home movies, it probably
has a USB or FireWire connector. If so, you can hook up the camcorder to your
computer, transfer the video to your hard drive, and edit it. To connect a cam-
corder to your PC, follow these steps:

1. Most digital camcorders come with a USB or FireWire cable.
Connect one end of the cable to the USB or FireWire port on the
camcorder, and then connect the other end of the cable to a USB or
FireWire port on your computer.

2. Windows should detect the new camcorder and search for “drivers” to
complete the installation. If Windows cannot find them, you will have
to install the proper drivers by using the installation CD that came
with the camcorder or by downloading them from the manufacturer’s
Web site.

3. Use the CD that came with the camcorder to install a special video-
editing program, which will enable you to transfer video clips to and
from your computer and edit those clips.

78 Part II • Enhancing Your PC Experience

10_77989x ch05.qxp  11/10/05  6:51 PM  Page 78



Connect a Video Game Controller
To play video games on your computer, you need to connect a game controller
such as a joystick, gamepad, or steering wheel.

Note
These steps apply only to USB video game controllers.

1. Connect your controller to a USB port on your computer.

2. Windows should detect the new controller and search for “drivers” to
complete the installation. If Windows cannot find them, you will have to
install the proper drivers by using the installation CD that came with the
controller or by downloading them from the manufacturer’s Web site.

3. After installation, configure and customize your controller by doing
the following:

a. Click the Start button in the lower-left corner of Windows.

b. Click the Control Panel. (If you don’t see this option, your Start
menu is in classic mode. In that case, click Settings, and then
select the Control Panel.)

c. If the Control Panel is in Category view, click the Printers and
Other Hardware category, and then click the Game Controllers
icon. If the Control Panel is in classic view, simply double-click
the Game Controllers icon.

d. A window opens. In it, click the name of your controller, and
then click the Properties button.

Connect a Scanner
If you have a large collection of family photos you want to preserve by digitizing
them into your computer, you will need to install a scanner.

For USB and FireWire scanners
1. Most scanners come with a USB or FireWire cable. Connect one end

of the cable to the USB or FireWire port on the scanner, and then
connect the other end of the cable to a USB or FireWire port on your
computer.

2. Most new scanners have their scanning heads locked to prevent them
from being damaged. To unlock the scanning head, look for a knob or
lever located near the scanner’s power cord or on/off switch.

3. Connect the power cord to the scanner, and then plug the other end
into an electrical outlet.

4. Windows should detect the new scanner and search for “drivers” to
complete the installation. If Windows cannot find them, you will have
to install the proper drivers by using the installation CD that came
with the scanner or by downloading them from the manufacturer’s
Web site.
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For parallel-port scanners
1. Shut down your computer before connecting the scanner.

2. Disconnect any devices that are currently connected to your com-
puter’s parallel port.

3. Connect one end of the parallel-port cable (which should have been
included with your scanner) to the parallel port on the scanner, and
then connect the other end to the parallel port on your computer.

4. If you disconnected a printer from the computer’s parallel port, con-
nect it to the printer port on the scanner.

5. Most new scanners have their scanning heads locked to prevent them
from being damaged. To unlock the scanning head, look for a knob or
lever located near the scanner’s power cord or on/off switch.

6. Connect the power cord to the scanner, and then plug the other end
into an electrical outlet.

7. Turn on your computer.

8. Windows should detect the new scanner and search for “drivers” to
complete the installation. If Windows cannot find them, you will have
to install the proper drivers by using the installation CD that came
with the scanner or by downloading them from the manufacturer’s
Web site.
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6
USING DIGITAL 
MUSIC PLAYERS

If you have been around long enough to remember vinyl
records and 8-track tapes, you might be amazed at how far
music technology has come. Now you can carry your entire

music collection with you in a tiny device that fits in your hand
or shirt pocket. Generally referred to as digital music players,
these gadgets have forever changed the way people listen to
music — and have made long plane rides or family road trips a
lot easier.

Choose a Digital Music Player
A typical digital music player — as shown in Figure 6-1 — can
hold hundreds or even thousands of songs. All of these players
fall into two categories: flash players that store music on inter-
nal or external flash memory cards, or hard-drive players that
store music on miniature hard drives. See the sections that fol-
low for advantages and disadvantages of each.

Note
Some digital music players require Windows XP and don’t work
with older versions of Windows. Also, some music players require
USB 2.0 ports on your computer and don’t work with older USB
1.1 ports.

Choose a digital
music player

Assemble a digital
music library

Solve common
problems

Do It Yourself
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Figure 6-1

Flash Players
• No moving parts: Because Flash players do not contain moving

parts that can be damaged, they are ideal to use during high-impact
activities such as jogging and other exercise.

• Less expensive: Typically between $99 and $200.

• Small and lightweight: Usually fits in the palm of your hand. Some
are the size of a pack of chewing gum.

• Holds hundreds of songs: The average storage
capacity is between 128MB and 1GB, which is
equivalent to 4 to 16 hours of music.

• Good battery life: Usually between 10 and 45
hours.

Hard-Drive Players
• Has moving parts: These players use a small

hard drive to store your music, which is similar to
the hard drive found in your computer. Because
hard drives have moving parts, they must be han-
dled carefully. Therefore, a hard-drive music player
should not be used during rigorous activities such
as jogging and exercising.

• More expensive: $200 to $400.

• Bigger and bulkier: Typically they are larger than flash players, but
most can still fit in your hand.
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• Holds thousands of songs: The average storage capacity is between
4GB and 60GB, which is equivalent to 60 to 1,000 hours of music.

• Shorter battery life: Usually between 12 and 20 hours.

• Additional features: Some players have fascinating enhancements
such as a touch screen, backlit screen, sleep timer, video games, a cal-
endar, to-do lists, and the capability to show digital photos or videos
and serve as an external hard drive for your computer.

Assemble a Digital Music Library
After you have purchased a digital music player, your next steps are to create a
digital music library and load the songs onto your player.

Convert CDs into Digital Songs
To transform the tracks on a standard music CD into digital files that can be
heard on your computer or music player, you need to “rip” the songs off the CD
and encode them into an audio format such as MP3 or WMA. To do that, you
will need to use a digital music program. Here are some popular titles (in no
particular order):

• Windows Media Player: Comes free with Windows XP

• MusicMatch Jukebox: www.musicmatch.com 

• Audiograbber: www.audiograbber.com-us.net

• dBpowerAMP Music Converter: www.dbpoweramp.com

• Easy CD-DA Extractor: www.poikosoft.com

Buy Digital Songs from Internet Music Stores
Another way to acquire digital songs is to purchase them from an Internet store.
Along with selling individual tracks for less than a dollar a piece, many of these
stores offer monthly or yearly subscription services that enable you to hear
streaming audio or download countless songs to your portable music player.
Here are the most popular online music stores (in no particular order):

• MSN Music: http://music.msn.com

• Napster: www.napster.com

• Yahoo Music Unlimited: http://music.yahoo.com/unlimited

• Music Now: www.musicnow.com

• Apple iTunes: www.apple.com/itunes

• Rhapsody: www.listen.com

• Wal-Mart Music Downloads: http://musicdownloads.walmart.com

• eMusic: www.emusic.com
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Load Songs onto Your Music Player
Once you have created or purchased digital songs, you can transfer them to your
player by following these steps:

Note
These steps apply to Windows XP only.

1. Using the USB or FireWire cable that came with your player, connect
one end to the player and the other end to a USB or FireWire port on
your computer. If this is your first time connecting the player,
Windows XP automatically attempts to install the proper “drivers”
that will enable the player to work with it. If this process is successful,
proceed to Step 2. If not, you need to install the correct drivers by
using the CD-ROM that came with the player.

2. After the player has been properly installed, you can transfer music to
it. Most players have two ways to do this:You can use its special soft-
ware (which is usually included on the installation CD-ROM that
came with the player), or you can use Windows. If you want to use the
player’s software, insert the CD into your computer, install the pro-
gram, and follow its onscreen instructions. If you want to use
Windows to transfer you music files, proceed to Step 3.

3. To transfer songs through Windows, double-click the My Computer
icon on your desktop. If this icon is not available, click the Start but-
ton in the lower-left corner of Windows and click My Computer. If
you can’t find the My Computer icon anywhere, do the following:

a. Right-click in the empty space on your desktop.

b. Select Properties.

c. A window opens. Click the Desktop tab.

d. Near the bottom of the window, click the Customize Desktop
button.

e. Another window opens. On the General tab, beneath the words
Desktop Icons, place a checkmark in the My Computer box.

f. Click OK.

g. You are returned to the previous screen. Click Apply.

h. Click OK.

i. The My Computer icon appears on your desktop. Double-click it.

4. A window opens. Double-click the icon for your portable music
player.

5. Another window opens, showing you the music currently stored on
the player (if any). This is the window into which you must place 
your songs in order to transfer them to your player. To do so, you 
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can drag the songs from your music folder and drop them into the
player’s window, or you can copy the songs and paste them into 
the player’s window.

6. When you are finished, disconnect the USB or FireWire cable from
your music player.

Solve Common Problems
Like any high-tech equipment, digital music players are not perfect. Here are
some common problems and their five-minute fixes.

Music Player Can’t Connect to Your PC
• Check the owner’s manual to see if you are using the player correctly.

• Try connecting your player to a different computer.

Songs Won’t Play Properly or Sound Distorted 
• Your music files might be corrupt or infected. To avoid this problem,

do not download illegal, pirated songs through file-trading software
such as LimeWire, Kazaa, or iMesh.

• To guarantee that the songs you download are completely legal, free
of distortion, and of  high digital quality, buy them from official
online music stores such as those listed in the section “Buy Digital
Songs from Internet Music Stores” earlier in this chapter.

Battery Life Drains Quickly
• Do not listen to your music at an extremely loud volume. Instead, use

a medium level.

• Do not listen to a snippet of one song and then immediately jump to
a new one. Instead of forcing your player to constantly search its
memory for the songs you want — which can drain battery power —
try listening to an entire song before selecting a new one.

• If your player has a backlight, use it sparingly.

• If your player has an audio equalizer or bass booster, use it sparingly.

Windows Media Audio Files Won’t Play Properly or at All
• Your Windows Media Audio (WMA) files might be using a copy pro-

tection feature such as DRM (digital rights management) or PRM
(personal rights management). Usually these protection schemes are
turned on when the WMA files are created. Therefore, if the songs
were not originally created to be used solely on your computer, there
isn’t much you can do to make them play.
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• If you use Windows Media Player or other CD-ripper programs to
make WMA files from your music CDs, disable the option to use
copy protection or DRM. Here’s how to do it in Windows Media
Player:

Note
This five-minute fix requires you to access Windows Media Player’s “menu bar,”
which contains the drop-down menus you must click in order to change the player’s
settings. If the menu bar does not automatically appear at the top of your player, you
can make it visible by simultaneously pressing the Ctrl key and the M key on your
keyboard.

1. Open Windows Media Player.

2. Click the Tools drop-down menu.

3. Select Options.

4. A window opens. Click the Rip Music tab.

5. Look for the Copy protect music option. Next to this option, remove
the checkmark from the box.

6. Click Apply.

7. Click OK.
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7
TROUBLESHOOTING

Let’s face it: Sometimes computers can be so frustrating
that they make you want to abandon them forever and
switch to an old-fashioned, reliable typewriter. But

before you take such a drastic action, scan through this chapter
to learn how to troubleshoot and solve common PC problems.

Computer Randomly Crashes or Displays
Blue Screen
If you have used Windows for several years, you have probably
experienced numerous freezes, crashes, or the error messages
jokingly referred to as “blue screens of death” (see Figure 7-1).
If shutting down and restarting your computer doesn’t solve
these problems, you might benefit from the fixes in the follow-
ing categories.

Computer randomly
crashes or displays blue
screen
Nothing happens when
the computer is turned on 
Computer takes a long
time to power up 
Computer continuously
accesses the hard drive 
Laptop battery life is
too short
Monitor has poor image
quality 
Screen flickers
Invalid system disk while
booting
Software installation
goes horribly wrong 
New hardware doesn’t
work
Computer or software
won’t respond
Keyboard won’t respond
Video game doesn’t
work correctly
No sound
Determine whether a
program or game will
run on your computer

Do It Yourself
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Figure 7-1

Software troubles
1. If you recently installed a new program, try uninstalling it. For more

information, see the 5-minute fix “Software Installation Goes Horribly
Wrong” later in this chapter.

2. If uninstalling the software solves your problem, contact its manufac-
turer for information on how to install the program properly so it
won’t conflict with Windows or with your other software.

Overheated computer
1. Download software to analyze the temperature inside your computer.

One option is to visit www.hmonitor.net and download a program
called Hardware Sensors Monitor. If you find the temperature in your
computer to be near the upper limit, which is generally 120 degrees
Fahrenheit, overheating is probably causing your problems.

2. Move your computer’s base unit so that it is at least 6 to 12 inches
away from all walls, desks, or anything else that might prevent air from
flowing into your PC through its fans and exhaust ports.

3. Listen for the sound of your computer’s internal cooling fans. If 
you don’t hear them, they may have malfunctioned. In that case,
replace them.

Malfunctioning USB hub
1. If you have a USB hub, disconnect it for a few hours to see if it is the

source of your troubles.

2. If removing the hub does not correct your problems, go ahead and
reconnect it.

If you have tried these fixes and your PC still has problems, it is possible that it
might have a software conflict, faulty memory, or a malfunctioning hard drive.
In that case, contact Geeks On Call.
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Nothing Happens When the Computer Is Turned On
If you attempt to start your computer but nothing happens — no lights, no fan
noise, no sounds, nothing — follow these steps:

1. Make sure your computer and your monitor are plugged into a power
strip or an electrical outlet.

2. If you are using a power strip, check to see if it is actually plugged into
an electrical outlet and is turned on. Most surge protectors have an
On/Off switch. Make sure this switch is set to the On position (which
usually causes a light to turn on).

3. Find out if the electricity in your home or office has malfunctioned:

a. See whether the lights in your room are working.

b. Plug a light into your computer’s power strip to see if that strip
is working properly. It is possible that the power strip has mal-
functioned.

4. If you are certain that both your computer and monitor are receiving
electrical power, it is possible that the power supply or another piece
of hardware inside your computer has died. In that case, call Geeks
On Call.

Computer Takes a Long Time to Power Up
Having a computer that is slow to start up doesn’t necessarily mean there is
something wrong with it. The slowness can be caused by important programs
that often take a while to load (such as antivirus software) or by having too
many programs on your computer.Your first remedy is to remove any software
you no longer use (such as old video games). If that doesn’t work, try adding
more RAM to your computer by following the 5-minute fix “Add More System
Memory (RAM)” in Chapter 2. If the slowness continues, try reducing the
amount of programs that load when Windows starts. Here’s how:

1. Click the Start button in the lower-left corner of Windows.

2. Click Run.

3. A window opens. Type msconfig in the blank, and then click OK or
press the Enter key on your keyboard.

4. A window named System Configuration Utility opens. Click the
Startup tab on the far right.

5. In the left column (Startup Item) is a list of programs with check-
marks next to them (see Figure 7-2). A checkmark indicates that the
program is scheduled to launch each time Windows starts. To prevent
a program from loading at startup, remove the checkmark from its
box. Here are guidelines about which programs to allow or to disable:

• Disable non-essential multimedia programs such as qttask (which
is part of the QuickTime software), realsched (which is part of
the RealPlayer software), or Adobe Reader.
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• Allow common processes for Windows and Microsoft Office.

• Allow programs related to your antivirus software, anti-spyware
software, or firewall. For example, if you use the ZoneAlarm fire-
wall and Spy Sweeper anti-spyware program, then you should
allow the startup programs named zlclient and SpySweeper.

• Allow programs related to your printer. For example, if you have
an Epson printer, then allow the startup program named Epson
Status Monitor.

Figure 7-2

6. If you are uncertain about whether or not to disable a particular 
program, do the following:

a. Write the program’s name on a piece of paper.

b. Connect to the Internet.

c. In your Web browser, type http://www.processlibrary.com to
visit the Process Library.

d. Near the top of this Web site’s main page is a search box labeled
Search for a Process. Type the name of your program into this
box, and then click the Search Now button.

e. You are taken to a Web page that explains what your program is
used for and whether or not it is essential to your computer’s
performance.

7. When you have finished tweaking the System Configuration Utility,
click Apply.

8. Click OK.

9. A message alerts you that you must restart your computer for the
changes to take effect. Click the Restart button.Your computer auto-
matically shuts down and reboots.
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10. When you return to Windows, a message alerts you that you have just
used the System Configuration Utility to change the way Windows
starts. Put a checkmark in the Don’t show this message or launch the
System Configuration Utility when Windows starts box.

11. Click OK.

Computer Continuously Accesses the Hard Drive
Does the hard drive in your computer sound like it is running non-stop? Does
the small light on the front of your computer constantly flash, indicating that the
hard drive is always being used? If so, your hard drive may be overworked
because you don’t have enough system memory (RAM). Here’s what to do:

1. Restart your computer.

2. Check how much RAM your computer has. For more information,
refer to the 5-minute fix “Determine Your Amount of System Memory
(RAM)” in Chapter 1.

3. Add more memory, preferably twice as much as your current amount.
For more information on doing this, refer to the 5-minute fix “Add
More System Memory (RAM)” in Chapter 2.

Laptop Battery Life Is Too Short
Laptop computers are quite convenient — assuming they have power. If you
can’t plug a laptop into an electrical outlet, it has to rely on batteries. Most lap-
tops run only two to three hours on a fully charged battery. To extend the life of
your laptop’s battery, do the following:

1. Lower the brightness of your screen.

2. Disable your wireless card. To do so, double-click the wireless icon 
in the lower-right corner of Windows, and then click Disable (see
Figure 7-3).

Figure 7-3

3. To reduce the battery’s usage and extends its life, configure the power
options in Windows.
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For Windows XP and Windows 2000
a. Click the Start button in the lower-left corner of Windows.

b. Click Control Panel. If you don’t see this option, your Start
menu is in Classic mode. In that case, click Settings and then
select the Control Panel.

c. If the Control Panel is in Category view, click the Performance
and Maintenance category and then click the Power Options
icon. If the Control Panel is in Classic view, simply double-click
the Power Options icon.

d. Select an appropriate Power Scheme (see Figure 7-4).

e. Click OK.

Figure 7-4

For Windows 98 and Windows ME
a. Click the Start button in the lower-left corner of Windows.

b. Click the Control Panel.

c. Double-click Power Management.

d. Select an appropriate Power Scheme.

e. Click OK.

4. If your battery continues to last for less than one hour, replace it.

Monitor Has Poor Image Quality
Poor image quality on your computer’s monitor can be annoying in more ways
than one. Not only does it make fine details in photos or videos difficult to see,
but it also causes eye strain. If the images on your monitor look grainy or dis-
torted, try the following:
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1. Increase the resolution of your monitor:

a. Right-click in the empty space on your desktop.

b. Select Properties.

c. A window opens. Select the Settings tab.

d. Move the Screen Resolution slider bar to a higher resolution. If
your current resolution is 640 × 480 pixels, move it to 800 × 600
pixels. If your current resolution is 800 × 600 pixels, move it to
1,024 × 768 pixels (see Figure 7-5).

Figure 7-5

2. Unplug the monitor from your computer and look for bent or missing
pins on the end of the monitor’s video cable. If some are bent, try
straightening them. If some are missing, you will need to replace the
cable.

3. If the images on your monitor are poor or grainy only when you use a
specific program such as a video game, you may need to upgrade your
video card to a newer model that can handle advanced graphics. For
more information, refer to the 5-minute fix “Replace Your Video
Card” in Chapter 2.

Screen Flickers
If your computer’s monitor appears to constantly flicker or blink, its “refresh
rate” is probably too low. Rather than suffer eye strain by continuing to use your
PC under those conditions, you should increase the refresh rate.

For Windows XP Home/Pro and Windows 2000
1. Right-click in the empty space on your desktop.

2. Select Properties.
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3. A window opens. Click the Settings tab.

4. Click the Advanced button.

5. Click the Monitor tab.

6. Choose a higher refresh rate (if available). Generally you want 75
Hertz or higher (see Figure 7-6).

Figure 7-6

7. Click OK.

8. If this doesn’t fix the problem, you may need to replace the monitor.

For Windows 98 and Windows ME
1. Right-click in the empty space on your desktop.

2. Select Properties.

3. A window opens. Click the Settings tab.

4. Click the Advanced button.

5. Click the Adapter tab.

6. Choose a higher refresh rate (if available). Generally, you want 75
Hertz or higher.

7. Click OK.

8. If this doesn’t fix the problem, you may need to replace the monitor.

Invalid System Disk While Booting
If, after turning on your computer, you see a message that says you have an
invalid system disk or that you need to remove a disk, you can easily solve this
problem:
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1. Eject the floppy disk from your floppy drive.

2. Press any key on your keyboard to restart your computer.

Software Installation Goes Horribly Wrong
Once in a while, installing a new program can wreak havoc with your entire
computer, causing it to freeze, crash, or not operate normally. If so, do the 
following:

1. Uninstall the software:

For Windows XP Home/Pro and Windows 2000 
a. Click the Start button in the lower-left corner of Windows.

b. Click the Control Panel. If you don’t see this option, your Start
menu is in Classic mode. In that case, click Settings, and then
select the Control Panel.

c. Double-click the Add or Remove Programs icon.

d. Select the software and click the Remove or Change/Remove
button (see Figure 7-7).

Figure 7-7

For Windows 98 and Windows ME
a. Click the Start button in the lower-left corner of Windows.

b. Click on Settings.

c. Click the Control Panel.

d. Double-click the Add or Remove Programs icon.

e. Select the software you want to remove, and then click the
Add/Remove button (see Figure 7-8).
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Figure 7-8

2. Shut down your computer and restart it.

3. If your computer still has problems after uninstalling the software, you
can use a last-ditch fix called System Restore. In a sense, System
Restore sends your computer back in time to a day when it was work-
ing properly. Here’s how to use it:

a. Click the Start button in the lower-left corner of Windows.

b. Click on All Programs.

c. Select Accessories.

d. Select System Tools.

e. Click the words System Restore.

f. The System Restore window opens. Click the Restore my com-
puter to an earlier time button (see Figure 7-9).

Figure 7-9
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g. Click the Next button, located near the lower-right corner of this
window.

h. A calendar appears. In it, click on a day when your computer
was working properly. For example, if your PC had problems
after installing Microsoft Works, choose that specific restore
point (see Figure 7-10).

Figure 7-10

i. Click Next.

j. To confirm your choice, click Next again.

k. The System Restore process begins. Moments later, your com-
puter automatically restarts itself. When it boots up, follow the
onscreen instructions.

New Hardware Doesn’t Work
If a new piece of hardware you just connected to your computer doesn’t work
properly — or not at all — follow these fixes:

1. Make sure you properly followed the hardware’s instructions word for
word (and make sure you followed the directions that apply to your
particular version of Windows).

2. Check the hardware to ensure that it is hooked up correctly and has a
secure connection. For example, if you installed a PCI card, make
sure it was properly snapped into place and is not loose. Or, if you
installed a printer, make sure its connection to the computer is tight
and secure.

3. Update Windows with the latest patches and drivers by visiting
http://windowsupdate.microsoft.com (don’t put a www in front of this
Web address).
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4. Try uninstalling and then reinstalling the hardware.

5. If the hardware still doesn’t work properly, check its documentation or
contact its manufacturer by visiting its Web site or calling its customer
support line.

Computer or Software Doesn’t Respond
One minute your computer is working fine. The next minute, everything freezes.
Windows, your software, and your mouse don’t respond to your commands.
Sound familiar? If you are a regular user of Windows, this scenario has probably
happened to you more than once. The next time it does, try the following:

1. Wait a minute because your computer may just be experiencing a tem-
porary freeze (which can happen if you try to open or run several pro-
grams at once).

2. Open the Windows Task Manager by simultaneously pressing the Ctrl,
Alt, and Delete keys on your keyboard. If 30 seconds have elapsed and
the Task Manager has not opened, proceed to Step 5.

3. When the Task Manager opens, click the Applications tab (see 
Figure 7-11).

Figure 7-11

4. If the Task Manager indicates that a particular task or program is not
responding, click its name, and then click the End Task button (see
Figure 7-12). If a window pops up and asks whether you want to end
the task or program, click the End Task button again.

5. If the troubled task or program continues to be unresponsive — or if
your computer as a whole is experiencing problems — save any open
documents (if you can), and then turn off your computer by pushing
or holding down the power button on the front of your computer.
Next, restart the computer.
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Figure 7-12

Keyboard Doesn’t Respond
If your keyboard suddenly stops working, it might be unplugged or damaged.
Here’s what to do:

1. Make sure your keyboard is connected to your computer. If not, plug
it back in and restart the computer.

2. If your keyboard is connected, slightly wiggle the connector and make
sure it fits snugly into the port. Next, restart the computer.

3. If your keyboard uses a PS/2 connector, it is possible that the connec-
tor has been damaged or has worn out. Look for bent or missing pins
on the end of the connector. If some are bent, try straightening them.
If some are missing, you will need to replace the keyboard.

Video Game Doesn’t Work Correctly
A common problem experienced by PC video-game users is slow or sputtering
graphics. If you experience similar issues, here are some tips:

1. Refer to Chapter 1 for information on analyzing your PC. After you
know what type of hardware and software your PC has, you can com-
pare it to the system requirements listed on the game’s package.

2. If your PC is not compatible with the game’s system requirements,
you might be able to upgrade some of your hardware components. For
more information on upgrading a PC, refer to Chapter 2.

3. If your PC meets the system requirements, refer to the owner’s man-
ual or documentation that came with the video game to see if it pro-
vides tips on troubleshooting problems. If the manual doesn’t list any
tips or if you don’t have a manual, contact the game’s manufacturer
by visiting its Web site or calling the customer support number.
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No Sound
Have your computer’s speakers suddenly gone silent? Then one of these fixes
should do the trick:

1. If you have external speakers, make sure they have been plugged into
an electrical outlet and have been turned on (usually a light will illu-
minate to indicate that the speakers are powered up).

2. Check to see if the sound on your computer has been turned down or
muted. Double-click the sound icon located in the lower-right corner
of Windows. If this icon is not available, do the following:

a. Click the Start button in the lower-left corner of Windows.

b. Click Programs (or All Programs).

c. Click Accessories.

d. Click Entertainment (or Multimedia).

e. Click Volume Control.

Look for any controls that have been muted or turned down, espe-
cially the main volume control (see Figure 7-13). If you can’t see all of
the controls, click the Options drop-down menu, and then select
Properties. Make sure that all of the volume controls are checked;
then click OK (see Figure 7-14).

Figure 7-13
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Figure 7-14

3. If you have external speakers, make sure their audio wires or cables
are connected properly.

4. If the sound still doesn’t work, your sound card or speakers might
have to be replaced.

Determine Whether a Program or Game Will Run on Your
Computer
Before buying new hardware or software, make sure they will work properly on
your computer by following this advice:

1. Refer to Chapter 1 for information on analyzing your PC. After you
know what type of hardware and software your PC has, you can com-
pare it to the system requirements listed on the package of the game
or program you want to install.

2. If your PC is not compatible with the program’s system requirements,
you might be able to upgrade some of your hardware components. For
more information on upgrading a PC, refer to Chapter 2.
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PART III
POPULAR PROGRAMS
If you are upgrading a PC or buying a new one, your choices of hardware are
seemingly endless. But when it comes to software, the pickings are slim. Most
categories of software are dominated by a particular program—for example,
Microsoft Word is the most widely used word processor, and Microsoft Excel is
the most popular spreadsheet. This section of the book examines several popular
software titles, which may already be installed on your computer, and gives you
5-minute fixes to help you master their important features.
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8
MICROSOFT WORD

Without a doubt, Microsoft Word is the most popular
word-processing program on Earth — for good rea-
sons. Not only is it easy to use, but it also has many

powerful features that you may not be aware of. This chapter
explores some things you can do to get the most out of Word.

Alter the Office Assistant
The Office Assistant is the animated paper clip that is sup-
posed to help you solve your Microsoft Word problems (but
more often than not, it seems to get in the way). If you want to
get rid of the assistant or change its animated character, follow
these fixes.

Make the Office Assistant Disappear
1. Right-click the Office Assistant.

2. Click Hide (see Figure 8-1).

Figure 8-1

Or

1. Click the Help drop-down menu.

2. Click Hide the Office Assistant (see Figure 8-2).

Alter the Office
Assistant

Change the default font

Tweak the toolbars

Copy and paste

Use Find and Replace

Change the headers and
footers

Automatically double-
space your document

Insert charts

Insert pictures into your
document

Change the margins

Use auto bullet and
numbering

Use the Format Painter

Print on envelopes

Print on template paper

Recover documents
after power outages

Convert a Word
document to a PDF file

Do It Yourself
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Figure 8-2

Make the Office Assistant Appear
1. Click the Help drop-down menu.

2. Click Show the Office Assistant.

Change the Office Assistant Character
1. Right-click the Office Assistant.

2. Click Choose Assistant (see Figure 8-3).

Figure 8-3

Change the Office Assistant’s Settings
1. Right-click on the Office Assistant.

2. Click Options.

3. Make any desired changes.

4. Click OK.
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Move the Office Assistant
1. Click the Office Assistant and hold.

2. Drag it to your desired location and release it.

Change the Default Font
If the old faithful Times New Roman 12-point font doesn’t excite you, or if you
find yourself constantly switching fonts when creating a new document, you can
change the default font to one you like better.

1. Click the Format drop-down menu.

2. Click Font.

3. Choose your preferred font settings (see Figure 8-4).

Figure 8-4

4. Click the Default button.

5. You will be asked if you want the default font to be changed. Click Yes.

Tweak the Toolbars
In Microsoft Word, a toolbar is a horizontal grouping of buttons that serve as short-
cuts to frequently used commands.To give Word a customized appearance, you can
choose which toolbars you want to use and where they should be positioned.

Control Which Toolbars Are Shown
1. Right-click on any toolbar. The toolbars that are currently being

shown will a have checkmark next to them.

2. Uncheck the toolbars you want to get rid of, and then click any you
want to use.
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Move the Toolbars
1. Move your cursor to the start of the toolbar.

2. When your cursor changes to an image that has four arrows (pointing
up, down, left, and right), use the left mouse button to click the tool-
bar. Be sure to keep the mouse button pressed down. Next, drag the
toolbar to your desired location. To drop the toolbar, release the
mouse button.

Copy and Paste
One of the simplest tasks you can do with a computer is also one of the most
useful: copying and pasting text.You can copy text from almost anything on
your computer, such as your Web browser, e-mail, and text files, and then paste
that information into another format. If you aren’t familiar with the different
ways to copy and paste text, here are some tips:

1. Highlight the text or other objects, and then tell the computer you
want to copy the selection by doing the following:

a. Simultaneously press the Control (Ctrl) key and the C key on
your keyboard.

b. An alternate method is to right-click the selection and select
Copy (see Figure 8-5).

Figure 8-5

c. Another method is to click the Edit drop-down menu and 
select Copy.
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2. After copying the text or other objects, you need to paste them by
clicking somewhere in the input field (such as in the middle of a para-
graph in a Microsoft Word document). Here’s how:

a. Simultaneously press the Control (Ctrl) key and V key on your
keyboard.

b. An alternate method is to right-click where you want to insert
the text, and then click Paste.

c. Another method is to click the Edit drop-down menu, and then
select Paste (see Figure 8-6).

Figure 8-6

Use Find and Replace
If you want to replace a particular word or phrase that appears multiple times in
your document, you don’t have to manually locate and delete each instance of it.
Instead, use the Find and Replace feature to handle the process automatically.

1. Click the Edit drop-down menu.

2. Click Replace.

3. The Find & Replace window opens. Specify what word you want to
find and what its replacement word should be.

4. For advanced search options, click the More button (see Figure 8-7).
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Figure 8-7

Change the Headers and Footers
Headers and footers are the parts of a document containing information that
remains the same on each page, such as the page number, date and time,
author’s name, and so forth. To access the header or footer in order to add or
remove text, follow these steps:

1. Click the View drop-down menu.

2. Click Header and Footer.

3. To view the footer, switch between header and footer by clicking the
button on the floating header and footer toolbar (see Figure 8-8).

Figure 8-8

Automatically Double-Space Your Document
Rather than manually double-space your document, you can automate the
process by doing the following:

1. Click where you want to start having the new line spacing or highlight
the text you want to have the new line spacing.

2. Click the Format drop-down menu.

3. Click Paragraph.

4. Set your desired spacing. For example, to double-space your text, click
the Line spacing drop-down menu, and then select Double (see
Figure 8-9).
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Figure 8-9

Insert Charts
Using charts is a great way to add more visual appeal to your Word documents.

Input Raw Data
To insert data into a chart, do the following:

1. Click the Insert drop-down menu.

2. Click Picture.

3. Click Chart.

4. Input your data using the example as your guide (see Figure 8-10).

Figure 8-10

5. To name the chart and axis, and to set other properties, click the
Chart drop-down menu. Next, click Chart Options (see Figure 8-11).
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Figure 8-11

6. When you are finished, click somewhere in the document, which will
take you out of the chart editor. Then you should see the finished
product.

Use Data from an Excel Document
A great time-saving technique is to import data into Word from an existing Excel
spreadsheet.

1. Click the Insert drop-down menu.

2. Click Picture.

3. Click Chart.

4. Click the Edit drop-down menu.

5. Click Import File.

6. Find and select a spreadsheet file.

7. Click Open.

8. If you have more than one sheet, select which one to import.

9. Click OK.

10. To name the chart and axis, and to set other properties, click the
Chart drop-down menu. Next, click Chart Options.

11. When you’re finished click somewhere in the document, and it will
take you out of the chart editor. Then you should see the finished
product (see Figure 8-12).
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Figure 8-12

Use a Table in Your Word Document
If you created a table in your Word document but think it is too boring, you can
easily turn it into an eye-pleasing chart.

1. Highlight the table you want to convert to a chart.

2. Click the Insert drop-down menu.

3. Select Picture.

4. Click Chart.

5. To name the chart and axis, and to set other properties, click the
Chart drop-down menu. Next, click Chart Options.

6. When you’re finished, click somewhere in the document, and it will
take you out of the chart editor. Then you should see the finished
product.

Insert Pictures into Your Document
A fun way to jazz up your Word documents is to insert pictures or photos into
them. Here’s how:

1. Click where you want to insert the picture.

2. Click the Insert drop-down menu.

3. Click Picture.

4. Click From File.
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5. Find and select the picture you want to insert into the document (see
Figure 8-13).

Figure 8-13

6. Click OK.You should now see the picture (see Figure 8-14).

Figure 8-14

Change the Margins
If you want to make the margins of your document wider or narrower, follow
these steps:

1. Click the File drop-down menu.

2. Click Page Setup.

3. Click the Margins tab.
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4. Specify the top, bottom, left, and right margins. If you want them to be
your new default settings, click the Default button, and then click Yes.

5. Click OK.

Use Auto Bullet and Numbering
Instead of manually adding numbers or bullet points to your lists, you can gen-
erate automatic lists.

1. To start a list, click the numbering or bullets icon on the formatting
toolbar (see Figure 8-15). If you don’t see these icons, you can make
them visible by right-clicking any toolbar and selecting Formatting.

Figure 8-15

2. To start a new entry in the list (such as number 2 of the list), press the
Enter key on your keyboard.

Use the Format Painter
If you use Word on a regular basis, you probably have had many headaches try-
ing to format your documents properly. Once you have a document formatted
exactly as you want it, you can use the “format painter” to apply that same for-
matting to any new text you create.

1. Highlight the selection that contains the formatting you want to copy
(see Figure 8-16).

2. Click the format painter icon located in the standard toolbar (see
Figure 8-16). If you don’t see this icon, you can make it visible by
right-clicking any toolbar and selecting Standard.
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Figure 8-16

3. Highlight the sections you what to paint with the same formatting.

Print on Envelopes
Instead of handwriting the names and addresses on the envelopes you mail, con-
sider using the envelope-printing feature of Microsoft Word. Not only will it give
your envelopes a professional look, but it will enable you to place graphics or
logos on them.

1. Click the Tools drop-down menu.

2. Click Letters and Mailings.

3. Click Envelopes and Labels.

4. Click the Envelopes tab.

5. Enter the destination and return address (see Figure 8-17).

Figure 8-17
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6. If you want to change the address’s font, or if the default feed method
for your printer doesn’t work, you can define these settings and more
by clicking the Options button.

7. Load the envelope into your printer. Most new printers have a special
envelope feeder or slot, while older models load the envelope in the
same manner that regular paper is loaded. See your printer’s user
manual for more information.

8. Click Print.

Note
If you would like to add a logo or graphics to your envelope, you should click Add
to Document before clicking the Print button. Then you can insert or drag images
into your document.

Print on Template Paper
Most office-supply stores carry an assortment of template paper such as address
labels or stickers. Most of these template papers are compatible with Microsoft
Word. Here’s how to use them:

1. Click the Tools drop-down menu.

2. Click Letters and Mailings.

3. Click Envelopes and Labels.

4. Click the Labels tab.

5. Click the Options button.

6. Select the product number of your paper (see Figure 8-18). This is
usually marked clearly on the product’s cover.

Figure 8-18

7. Click OK.

8. Click the New Document button.

9. Enter your desired information into the defined sections (see 
Figure 8-19).
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Figure 8-19

10. Load the template paper into your printer.

11. Print by clicking the print icon on the standard toolbar. Or click the
File drop-down menu, select Print, set any specific settings, and then
click OK to print.

Recover Documents After Power Outages
If the power goes out while you are in the middle of using Microsoft Word, you
should be able to recover the document you were working on.

1. Simply turn your computer back on, if needed.

2. Start Microsoft Word.

3. You should see the Document Recovery task pane on the left (see
Figure 8-20).

If a document is listed as Recovered, that is the last auto-saved version
of it — which means it might be missing a few minutes of your work
(because by default, the auto-save feature saves you files only every 10
minutes).

If your document(s) is listed as Original, it’s the last manually saved
copy of your document.
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Figure 8-20

Convert a Word Document to a PDF File
A popular way to distribute documents is to convert them to PDF files. By using
this format, you can prevent people from illegally copying or printing the text in
your document. To read a PDF or to convert a file to that format, you must
install special software.

1. Download a PDF converter. There are simple, free versions available
on the Internet (such as PrimoPDF), as well as more professional ver-
sions that can be purchased (such as Click to Convert).

2. Depending on which converter you use, you may have a special button
on your Word toolbar that allows you to instantly convert a Word doc-
ument to a PDF. If not, then you can probably achieve the same out-
come by clicking the File drop-down menu, selecting Save as, and
then choosing PDF.
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9
MICROSOFT EXCEL

Microsoft Excel is arguably the most popular spread-
sheet program in the world.You can use it to help
you with invoices, budgets, or just about anything

with numbers. When using the functions and other features in
Excel, you might run into problems or need advice to help you
along. This chapter examines the most common Excel issues
and offers fast solutions.

Correct a Cell That Displays “#NAME?”
If a cell in your Excel document displays text that says
“#NAME?” (see Figure 9-1), that means the formula is invalid
and needs to be corrected. To do so, check the formula by
clicking the cell. Next, look for these typical errors:

• Misspelling of the function’s name, such as SUM or
AVERAGE.

• Text within formulas needs to be in quotation
marks.

• The colon in a range is missing.

• Single quotation marks are missing from around the
sheet name if the formula calls data from another
sheet.

Correct a cell that
displays “#NAME?”

Use multiple sheets
in one document

Use AutoFormat

Use sorting 

Use functions

Change the format of
cells

Create charts

Import real-time data
from the Web

Reveal hidden cells

Webpage Preview
doesn’t work

Recover corrupt
documents

Do It Yourself
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Figure 9-1

Use Multiple Sheets in One Document
Using multiple sheets within one Excel document can be very useful.

Go to Other Sheets
To go to another sheet, click its tab in the lower-left corner (see Figure 9-2).

Figure 9-2
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Rename a Sheet
You can give your sheet a new name.

1. Right-click the tab of the sheet you want to rename.

2. Click Rename.

3. Type a new name (see Figure 9-3).

Figure 9-3

4. To apply the changes, press Enter on your keyboard.

Move a Sheet
You can change the order in which the sheet’s tabs appear in the lower-left corner.

1. Click the tab of the sheet you want to move, making sure to hold
down the mouse button.

2. Drag the tab to the position you desire by using the arrows for refer-
ence (see Figure 9-4).

3. When the arrow is pointing to your desired location, release the mouse
button.
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Figure 9-4

Create a Sheet
If you used up all of the sheets, you can easily add more.

1. Click the Insert drop-down menu.

2. Click Worksheet.

3. Rename the worksheet if necessary.

Tip
To get rid of an unused worksheet in your document, right-click on the sheet’s tab
and click Delete.

Use AutoFormat
Using AutoFormat allows you to display your data in a professional and flashy
style.

1. Highlight the data you want to AutoFormat.

2. Click the Format drop-down menu.

3. Select your desired style (see Figure 9-5), and then click the Options
button to define which individual formats to apply.

4. To apply the format, click OK.
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Figure 9-5

Use Sorting
You can use the sorting feature to sort your data quickly.

1. Highlight the data you want to sort (see Figure 9-6).

Figure 9-6

2. Click the Data drop-down menu.

3. Click Sort.

4. Choose whether to sort in ascending order or descending order, and
select your other options. (See Figure 9-7).

5. To sort your data, click OK.
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Figure 9-7

Use Functions
Functions are some of the best and most powerful features of Excel. They can
do simple work for you such as calculating the sum and average of defined cells
or solving complex problems such as asset deprecation.

1. Select where you want to insert the function.

2. On the standard toolbar, click the arrow on the function icon. Next,
select a common function (see Figure 9-8) or click More Functions.
An alternate method is to click the Insert drop-down menu, click
Function, and then select a function (see Figure 9-9).

Figure 9-8
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Figure 9-9

3. After applying the function, Excel automatically chooses a range of
cells to use in the function, as defined by the blue box. If the range of
cells is incorrect, resize the blue box as necessary by using the corners
(see Figure 9-10).

Figure 9-10

4. When you are finished, press the Enter key on your keyboard.

Note
If you would like to define cells that are not located directly next to each other, hold
down the Control key (Ctrl) on your keyboard and highlight the cell(s).
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Change the Format of Cells
You change the format of the cells to a specific category such as Currency or
Percentage, and you can change the font and properties.

1. Highlight the cell(s) you want to format.

2. Right-click the cell(s).

3. Click Format Cells.

4. Click the Number tab.

5. Select a category (see Figure 9-11). For example, choosing Currency
will automatically add the dollar sign to the cell(s).

Figure 9-11

6. Click the Alignment tab (see Figure 9-12). This is where you can set
the position of the text within the cell(s), along with the wrapping of
the text, the shrinking of text to fit within the cell(s), and the merging
of cells.

Figure 9-12
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7. Click the Font tab. This is where you can change the font of the
selected cell(s).You can also set the borders, patterns, and protection
of the selected cell(s) by going to their tabs.

8. When you are finished, click OK.

Create Charts
Using charts is a great way to add pizzazz to your documents and present your
data in a more appealing way.

1. Highlight the cells you want to convert to a chart (see Figure 9-13).

Figure 9-13

2. Click the Insert drop-down menu.

3. Click Chart.

4. Select a chart type and sub-type (see Figure 9-14).
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Figure 9-14

5. Click Next.

6. If you need to redefine the cells you will use when creating the chart,
click the button on the right side of the data-range field. If needed,
change the series in the field.

7. Click the Series tab. This is where you can name the series and define
where to grab the series values and labels.

8. Click Next. This is where you name the chart and axes.

9. Click Next. Specify whether to create the chart in the existing sheet or
in a new sheet.

10. Click Finish to see your finished product (see Figure 9-15).

Figure 9-15
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Import Real-Time Data from the Web
Importing real-time data from the Internet is a helpful way to retrieve informa-
tion that can be inserted into your documents.

1. Choose where you want the data to be inserted by selecting a cell.

2. Click the Data drop-down menu.

3. Click Import External Data.

4. Click New Web Query.

5. Go to a Web site and select a table to import by clicking its arrow (see
Figure 9-16).

Figure 9-16

6. Click Import.

7. Select where to import the data: either in the current worksheet or a
new worksheet.

8. Click Properties. This is where you can set the properties of the data
you are importing — for example, how often to refresh the data (see
Figure 9-17). Click OK when you are finished.
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Figure 9-17

9. Click OK to import the data (see Figure 9-18).

Figure 9-18

Note
After you have imported data, you can change its properties by right-clicking it and
then clicking Data Range Properties.

Reveal Hidden Cells
If some of the rows or columns in your Excel document have been hidden and
you don’t know how to reveal them, follow these steps:
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1. Select the entire document by simultaneously pressing the Control
key(Ctrl) and the A key on your keyboard.

2. Click the Format drop-down menu.

3. If you want to reveal a hidden row, click on Row. If you want to reveal
a hidden column, click on Column.

4. Click Unhide.

Web Page Preview Doesn’t Work
If you have tried to preview your document as a Web page but it doesn’t do any-
thing, check to see if the document is protected. If password protection has been
enabled on it, that is probably the source of your problems. In that case, try to
unprotect the document while previewing as a Web page.

1. Click the Tools drop-down menu.

2. Click Unprotect Document.

3. Enter the password.

4. Try the Web page preview again.

Recover Corrupt Documents
If an Excel document becomes damaged or corrupt, you can try to repair it by
using this fix:

1. Click the File drop-down menu.

2. Click Open.

3. Find and select the document that is corrupt.

4. Click the arrow on the Open button.

5. Click Open and Repair.

6. Click Repair.

7. If that doesn’t work, you can try to save some of your work by extract-
ing the data. Just follow the same steps, but when you get to Step 5,
click the Extract Data button.

8. After you have successfully repaired your document, make sure all of
its errors have been corrected. Save your document as a Web page,
and then open the Web page document in Excel. Next, change it back
to a regular Excel document by using Save As from the File drop-
down menu.
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10
MICROSOFT
OUTLOOK

When it comes to e-mail, Microsoft Outlook is the pre-
eminent program. Along with making e-mail easy to
manage on desktop and laptop computers, Outlook

also helps you stay connected wherever you go by enabling you
to transfer your messages to a PDA (personal digital assistant)
or a Pocket PC. If you are unfamiliar with Outlook, be sure to
read all of the essential topics discussed in this chapter. They
will tell you what you need to know to become an Outlook pro.

Choose Your Default E-Mail Application
If you prefer using Outlook but have discovered that another
e-mail program launches when you click the e-mail link on a
Web site, you can fix this problem by setting Outlook as your
default e-mail application.

For Internet Explorer 5 and 6
1. Open Internet Explorer.

2. Click the Tools drop-down menu.

3. Select Internet Options.

4. Click the Programs tab.

5. In the E-mail drop-down menu, select Microsoft
Outlook (see Figure 10-1).

6. Click Apply.

7. Click OK.

Choose your default
e-mail application

Add an e-mail
account

Add an AOL e-mail
account

Choose a default
e-mail account

Configure your e-mail
download settings

Create additional
folders 

Save your data

Restore your data

Save copies of e-mail
on the server

Unable to send or
receive e-mail

Create an automatic
signature

Automatically send
and receive e-mail

Search for e-mail

Do It Yourself
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Figure 10-1

For Internet Explorer 4
1. Open Internet Explorer.

2. Click the View drop-down menu.

3. Select Internet Options.

4. Click the Programs tab.

5. In the Mail drop-down list, select Microsoft Outlook.

6. Click Apply.

7. Click OK.

Add an E-Mail Account
In order to send and receive e-mail through Outlook, you must add an e-mail
account.

For Outlook 2002 (also known as Outlook XP) and Outlook 2003
1. Click the Tools drop-down menu.

2. Click E-mail Accounts.

3. Click the Add a new e-mail account option (see Figure 10-2).

4. Click Next.

5. Select the type of e-mail server your account uses. If you don’t know,
ask your e-mail service provider.

6. Click Next.
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Figure 10-2

7. Enter the information given to you by your e-mail service provider. If
you are setting up a POP3 account, you can see if it works by clicking
the Test Account Settings button (see Figure 10-3).

Figure 10-3

8. When you are finished, click Next.

9. Click the Finish button.

Add an AOL E-Mail Account
If you have an account with America Online, you can con-
figure Outlook to download your AOL e-mail.

For Outlook 2002 (also known as Outlook XP) and 
Outlook 2003

1. Click the Tools drop-down menu.

2. Click E-mail Accounts.

3. Click on Add a new e-mail account.
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4. Click Next.

5. Select IMAP (see Figure 10-4).

Figure 10-4

6. Click Next.

7. Enter the appropriate information into the boxes.

a. Be sure to enter your full e-mail address — for example, screen-
name@aol.com.

b. Enter your AOL screen name and password for the username
and password fields.

c. For the incoming mail server (IMAP) field, use imap.aol.com
and for the outgoing mail server (SMTP) use smtp.aol.com.

8. Click the More Settings button.

9. Click the Outgoing Server tab (see Figure 10-5).

Figure 10-5
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10. Check the My outgoing server requires authentication option.

11. Select the Use same settings as my incoming mail server option.

12. Click the Advanced tab.

13. In the Outgoing mail (SMTP) field, type 587.

14. Click OK.

15. Click Next.

16. Click Finish.

Choose a Default E-Mail Account
If you have several e-mail accounts set up in Outlook, one of them will be
selected as your default account (which means it will be the account that
appears when you create a new e-mail). If you want to make a different account
the default, do the following.

For Outlook 2002 (also known as Outlook XP) and Outlook 2003
1. Click the Tools drop-down menu.

2. Click E-mail Accounts.

3. Select the View or change existing e-mail accounts option.

4. Click Next.

5. Click on the e-mail account you want to use as your default account.

6. Click the Set as Default button (see Figure 10-6).

Figure 10-6

7. Click the Finish button.
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Configure Your E-Mail Download Settings
Outlook allows you to decide whether an entire e-mail should be downloaded or
just its header. The sections that follow show how to change those settings.

For Outlook 2002 (also known as Outlook XP) and Outlook 2003
1. Click the Tools drop-down menu.

2. Click Send and Receive Settings.

3. Click the Define Send and Receive Groups option.

4. Click the Edit button.

5. In the account list on the left, click the appropriate account (see
Figure 10-7).

Figure 10-7

6. Click the folder that contains the settings you want to change.

7. If using a POP3 account, you can select the Download item descrip-
tion only option, which downloads only the header information,
requiring you to manually retrieve the other information later. Or you
can select the Download complete item including attachments option,
which downloads entire e-mail messages from the server.

8. If you are using an Exchange Server and want to create a limit for the
size of the e-mail messages you download, you can check the Inbox’s
checkbox and select the Download only headers for items larger than
option. Using this option means that if an e-mail (including any
attachments) is over the size limit, Outlook downloads only the header
and not the full message.
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9. If you are using IMAP and HTTP accounts, you can select the
Download item description only option (which downloads only the
header information) or the Download complete item including attach-
ments option (which downloads entire e-mail messages from the
server).

10. Click OK.

11. Click Close.

Create Additional Folders 
An easy way to organize your e-mail and reduce the clutter in your Inbox is to
create new folders to store your messages.Here’s how.

For Outlook 2002 (also known as Outlook XP) and Outlook 2003
1. Click the File drop-down menu.

2. Click New.

3. Click Folder.

4. Give the folder a name.

5. Specify what will be in the folder by selecting an option from the
Folder contains drop-down menu.

6. Select the folder you would want to create the new folder in (such as
the Inbox). If you want to create a main folder, select the top entry.

7. Click OK to create the folder.

8. When prompted, specify whether or not to add a shortcut to the new
folder on the Outlook Bar (it will be listed on the My Shortcuts tab).

Note
To view all your folders, click the View drop-down menu and click Folder List. 

Save Your Data
To prevent your e-mail and other Outlook data from being wiped out by a hard-
drive crash or a virus, be sure to back them up by doing the following.

For Outlook 2002 (also known as Outlook XP) and Outlook 2003
1. Click the File drop-down menu.

2. Click Import and Export.

3. Click Export to a file (see Figure 10-8).
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Figure 10-8

4. Click Next.

5. From the list, select the type of file you want to save your data as. The
recommended option is Personal Folder File (.pst).

6. Click Next. If the selected file type has not been installed, it will
prompt you to do so.

7. Select the folder or subfolder in which your file will be saved.

8. Click Next.

9. If you want to save the exported file to a location that is not in the list,
click the Browse button. Next, you should find and select a destina-
tion; then click OK.

10. Select a choice from the options section.

11. Click Finish to start exporting your e-mails. Keep in mind that
depending on the amount of data you are exporting, this can take 30
minutes or more.

Note
Depending on the amount of data you are exporting, the file size could be very large
(several hundred megabytes or more). Keep this in mind if you don’t have a lot of
hard-drive space available or if you plan to save your files to a removable disk such
as a recordable CD. 

Restore Your Data
If you are moving from an old computer to a new one, or if you are recovering
from a serious computer problem such as hard-drive failure, you will need to
restore the Outlook files you previously backed up.

For Outlook 2002 (also known as Outlook XP) and Outlook 2003
1. Click the File drop-down menu.

2. Click Import and Export.

142 Part III • Popular Programs

16_77989x ch10.qxp  11/10/05  6:53 PM  Page 142



3. Select the Import from another program or file option (see 
Figure 10-9).

Figure 10-9

4. Click Next.

5. Select the type of exported file (which likely is Personal Folder 
File .pst).

6. Click the Browse button.

7. Find and select the file to import.

8. Click Open.

9. Select an option from the options section.

10. Click Next.

11. Select the folder you want to import. If you would like to import all
folders, select the top entry and make sure you check the Include sub-
folders option.

12. If you want to import the folders into the active folder, select the
option Import items into the current folder. If you want to import the
folders into those that have the same name as the folders you previ-
ously chose from the drop-down list, select the option Import items
into the same folder.

13. Click Finish to begin importing your data. Keep in mind that depend-
ing on the amount of data you are importing, this can take 30 minutes
or more.

Save Copies of E-Mail on the Server
When you download e-mail from your Internet provider, those messages are
removed from the provider’s computers (known as “servers”). That means that if
your computer crashes and your files are lost, your e-mail will be gone forever
(unless you backed it up). Fortunately, Outlook gives you the option to save
copies of your e-mail on your Internet provider’s servers.
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For Outlook 2002 (also known as Outlook XP) and Outlook 2003 using POP3
accounts

1. Click the Tools drop-down menu.

2. Click E-mail Accounts.

3. Select the option View or change existing e-mail accounts.

4. Click Next.

5. Select your e-mail account (see Figure 10-10).

Figure 10-10

6. Click the Change button.

7. Click the More Settings button.

8. Click the Advanced tab.

9. Under the Delivery section, check the option Leave a copy of mes-
sages on the server.

10. Specify if you want to have the e-mail removed from the server peri-
odically or when you delete them from Outlook’s deleted items.

11. Click OK.

12. Click Next.

13. Click Finish.

Unable to Send or Receive E-Mail
One of the most common problems people have with Outlook is difficulty send-
ing or receiving e-mail. If you experience similar problems, see the sections that
follow for some advice.
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View Error Details
Reading the details of Outlook’s error messages might help you figure out why
you are unable to send or receive e-mail.

1. Click the Tools drop-down menu.

2. Click Send and Receive Settings.

3. Click Show Progress. If you do not see any details, click the Details
button.

Causes of Errors
There are several reasons why you might be having problems sending and
receiving e-mail:

• You might not have an Internet connection.

• The e-mail server information specified during setup might be 
incorrect.

• Your e-mail server might be down. Check with your provider.

• Spam filters might be blocking e-mail. Contact your provider to see if
you have spam controls enabled on your e-mail account.

Create an Automatic Signature
Another great feature of Outlook is the ability to create an e-mail signature.
Basically, this signature is a group of text — such as your name, phone number,
and address — that appears at the bottom of every new e-mail you create. To set
up a signature or change an existing one, follow the steps below.

For Outlook 2002 (also known as Outlook XP) and Outlook 2003
1. Click the Tools drop-down menu.

2. Click Options.

3. Click the Mail Format tab.

4. Under the signature section, click the Signatures button.

5. Click New.

6. Specify a name for your new signature.

7. Click Next.

8. Type or paste your desired signature (see Figure 10-11).You can use
the formatting buttons to format your signature.
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Figure 10-11

9. Click Finish.

10. Click OK.

11. To specify whether you want to include your signature in replies and
forwards, select your new signature from the drop-down list (see
Figure 10-12).

Figure 10-12

12. Click OK.

Automatically Send and Receive E-Mail
If you desire, you can configure Outlook to send and receive e-mail at regular
intervals, such as every 15 minutes, every 30 minutes, and so on.
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For Outlook 2002 (also known as Outlook XP) and Outlook 2003
1. Click the Tools drop-down menu.

2. Click Send and Receive Settings.

3. Click Define Send and Receive Groups.

4. Select the desired group (if more than one). See Figure 10-13.

Figure 10-13

5. Check the option Schedule an automatic send/receive every “X”
minutes.

6. Specify the time interval by entering a number into the minutes field.

7. Click Close.

Search for E-Mail
Like most e-mail users, you probably have an Inbox full of messages numbering
in the hundreds (or even the thousands!). This can make it extremely difficult to
find one specific e-mail. Fortunately, Outlook has a few search methods that can
help you quickly locate a particular message.

Simple Find — For Outlook 2002 (also known as Outlook XP) and Outlook 2003
1. Click the Tools drop-down menu.

2. Click Find.

3. In the Look for box, type a word, phrase, or other information such as
an e-mail address.

4. Indicate where to search by selecting a choice from the Search In
drop-down menu (see Figure 10-14).
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Figure 10-14

5. If you want to search entire e-mail messages instead of just their head-
ers, click the Options button (located on the right of the toolbar
named Find). Next, select the option Search all text in each message.

Advanced Find — For Outlook 2002 (also known as Outlook XP) and Outlook
2003

1. Click the Tools drop-down menu.

2. Click Advanced Find.

3. To select what you want to search for, click the Look for drop-down
menu (see Figure 10-15).

Figure 10-15
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4. To select where to search, click the Browse Next
button, check the appropriate folders, and then
click OK.

5. Specify how to search, using the criteria you
input. Don’t forget to use the More Choices and
Advanced tabs.

6. When you are ready to begin the search, click the
Find Now button.
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11
MICROSOFT 
WORKS 8

Microsoft Works 8 is similar to the Microsoft Office
software, but it streamlines the programs and pro-
vides a portal containing shortcuts to the applica-

tions, templates, and other features — all in one spot. If you are
moving from the Microsoft Office suite to Works, or if you are
using both at the same time, you need to make the documents
compatible.

Stop AOL Instant Messenger from 
Popping Up
If you have America Online’s Instant Messenger software
installed on your PC and you open Outlook Express from
Works, you will notice that the AOL Messenger automatically
launches and signs into your account (if you have one). To pre-
vent this from happening, do the following:

1. Open Outlook Express from the Microsoft Works
task launcher.

2. Click the Tools drop-down menu.

3. Select Options.

4. In the General section, remove the checkmark from
the Automatically log on to AOL Instant Messenger
box (see Figure 11-1).

5. Click OK.

Stop AOL Instant
Messenger from
popping up

Open documents
from previous
versions of Works

Open a Microsoft
Office document

Save files so others
can read them

Clear your document
history

Use a different Web
browser

Make Outlook
Express your default
e-mail program

Do It Yourself
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Figure 11-1

Open Documents from Previous Versions of Works
If you have upgraded to Works 8, you can still open documents from previous
versions of Works.

1. Open the particular Works program (word processor, spreadsheet, or
database) to which the file belongs. For example, if the file you want
to open is a Microsoft Word document, you should open Works Word
Processor. If it is a Microsoft Excel document, you should open Works
Spreadsheet.

2. Click the File drop-down menu.

3. Click Open.

4. Select the version of the Works document from the Files of type field
(see Figure 11-2).

Figure 11-2

152 Part III • Popular Programs

17_77989x ch11.qxp  11/10/05  6:53 PM  Page 152



5. Find and select the file.

6. Click the Open button.

Open a Microsoft Office Document
Microsoft Works can open almost any document created by a Microsoft Office
program. Here’s how:

1. Open the particular Works program (word processor, spreadsheet, or
database) to which the file belongs. For example, if the file you want
to open is a Microsoft Word document, you should open Works Word
Processor. If it is a Microsoft Excel document, you should open Works
Spreadsheet.

2. Click the File drop-down menu.

3. Click Open.

4. In the Files of type field, select the Microsoft Office program to which
the file belongs. For example, if you are trying to open a Microsoft
Word document, you select Word 97–2003 (*.doc). See Figure 11-3.

Figure 11-3

5. Find and select the file.

6. Click the Open button.

Save Files So Others Can Read Them
To share your Works documents with people using Microsoft Office, do the 
following:

1. Launch the Works program, and then click the File drop-down menu.

2. Click Save As.

Chapter 11: Microsoft Works 8 153

17_77989x ch11.qxp  11/10/05  6:53 PM  Page 153



3. In the Files of type field, select the type of Microsoft Office format
you want to save your Works document as. For example, if you want
to save your word-processing document as a Microsoft Word docu-
ment, select Word 97–2003 (*.doc).

4. Specify a filename (see Figure 11-4).

Figure 11-4

5. Find and select the folder in which you want to save your document.

6. Click Save.

Clear Your Document History
To prevent prying eyes from seeing the list of documents you have recently
opened or used, do the following:

1. Go to the Works task launcher. On the top of it, click the History icon.

2. Click the Clear History button (see Figure 11-5).

3. To confirm your decision to delete the history entries, click Yes.
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Figure 11-5

Use a Different Web Browser
If you like using the Web site shortcuts in the Works templates but don’t want to
use the particular Web browser that automatically launches, you can change the
settings for your default browser.

For Netscape 7
1. Start Netscape.

2. Click the Edit drop-down menu.

3. Click Preferences.

4. Click the Set Default Browser button.

5. Click OK.

For Netscape 8
1. Start Netscape.

2. Click the Tools drop-down menu.

3. Click Options.

4. Under the Default Browser section, click the Check Now button (see
Figure 11-6).
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Figure 11-6

5. When prompted, click Yes (see Figure 11-7).

Figure 11-7

For Internet Explorer (All Versions)
1. Close any open Internet Explorer windows.

2. Open your Control Panel.

a. In Windows 98 or Windows ME this is done by clicking the
Start button in the lower-left corner of Windows, clicking
Settings, and then clicking the Control Panel.

b. In Windows XP Home/Pro and Windows 2000, this is done by
clicking the Start button in the lower-left corner of Windows,
and then clicking the Control Panel. If you don’t see this option,
your Start menu is in classic mode. In that case, click Settings
and then select the Control Panel.

3. Double-click the Internet Options icon.

4. Click the Programs tab.

5. Select the Internet Explorer should check to see whether it is the
default browser option (see Figure 11-8).

6. Click OK.

7. Open Internet Explorer.

8. When you are prompted to make Internet Explorer the default
browser, click Yes.
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Figure 11-8

Make Outlook Express Your Default E-Mail Program
If you like using Outlook Express to send and receive e-mail but can’t get it to
launch when you click the e-mail button in your Web browser, you can fix this
problem by making Outlook Express your default e-mail program.

1. Open Outlook Express from the Microsoft Works task launcher.

2. Click the Tools drop-down menu.

3. Click Options.

4. In the Default Messaging Programs section, click the Make Default
button (see Figure 11-9).

Figure 11-9

5. Click OK.
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12
QUICKEN

Quicken moves your banking and checking experiences
into the digital world. Instead of keeping that old
leather checkbook up to date, you can log on to your

PC and print your checks.You can also track your spending,
monitor accounts, create budgets, and get help with your taxes.

Back Up Your Quicken Files
Backing up your Quicken data on a regular basis will prevent
your critical financial data from being permanently lost as a
result of a sudden hard-drive crash.

1. Insert a floppy disk or recordable CD into your 
computer.

2. In Quicken, click the File drop-down menu.

3. Click Backup.

4. Click Browse. This enables you to select the location
where you want to back up your files (in this case,
your floppy disk or recordable CD). When you’re fin-
ished, click OK (see Figure 12-1).

5. Click OK to complete the backup.

Note
If you receive a warning message about the file being too large,
you need to use a floppy disk or CD with more free space or a
much larger disk such as an external hard drive.

Back up your Quicken
files 

Restore your data

Set a password

Set up additional
accounts

Set up online account
access and bill
payment

Migrate from
Microsoft Money

Void and delete
transactions

Change a deposit you
entered incorrectly

Change a transfer
you entered
incorrectly

Find previous
transactions

Do It Yourself
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Figure 12-1

Restore Your Data
If a computer virus or hard-drive crash wipes out your Quicken data, you can
easily restore it — assuming you backed it up recently.

1. Insert the floppy disk or recordable CD containing your backed-up
Quicken files.

2. In Quicken, click the File drop-down menu.

3. Click Restore Back File.

4. Find and select the backup file located on your floppy disk or record-
able CD. When you’re finished, click OK (see Figure 12-2).

Figure 12-2

5. If you receive a message asking whether you want to overwrite or
replace the current file with the one stored on the floppy disk or
recordable CD, click OK.

6. Update the account registers as necessary if you have made any
changes since the time you created the backup file.
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Set a Password
To prevent your children or Internet intruders from looking at your sensitive
financial information, you can protect your Quicken files with a password.

1. Click the File drop-down menu.

2. Select Passwords.

3. Select File.

4. In the New Password box, type a password of your choosing.

5. In the Confirm Password box, type your password a second time (see
Figure 12-3).

6. Click OK.

Figure 12-3

Set Up Additional Accounts
If you didn’t set up all of your checking, savings, and money-market accounts when
Quicken was installed, or if you have new accounts, you can easily add them.

1. Click the Cash Flow Center button located on the left edge of the
window.

2. Click Add Account (see Figure 12-4).

3. Identify the financial institution.

4. Click Next.

5. Select your financial institution from the list. If it isn’t listed, click
None of These.

6. Select the type of account (see Figure 12-5).

7. Click Next.

8. Name the account

9. Click Next.

10. Enter the account balance date (see Figure 12-6).

11. Click Done.
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Figure 12-4

Figure 12-5

Figure 12-6
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Set Up Online Account Access and Bill Payment
Paying your bills over the Internet not only saves time and money (because you
no longer have to buy stamps), but it also ensures you won’t be slapped with late
fees if your bills are lost in the mail.

1. Get details from your bank on how to sign up for online account
access and bill payment through Quicken.

2. After receiving the details and information, start Quicken.

3. Click the Cash Flow Center button.

4. Click the account you are setting up.

5. Click the Set Up Now button, which appears at the bottom of the reg-
ister area (see Figure 12-7).

Figure 12-7

6. Enter a customer-identification number and a personal-identification
number (PIN).

7. Click OK.

Migrate from Microsoft Money
If you are currently using Microsoft Money to manage your finances and want
to switch to Quicken, follow these steps.

Warning
When converting files from Microsoft Money to Quicken, some of your financial data
might become jumbled or lost. 

1. In Microsoft Money, export your data file to a QIF file.

2. Start Quicken.
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3. Click the File drop-down menu.

4. Select Import.

5. Click QIF File.

6. Find and select the QIF file, and then follow the onscreen instructions.

Void and Delete Transactions
If you made a mistake and need to undo a transaction, you can either void or
delete it.

1. In the register, highlight or select the transaction(s) you want to delete
or void.

2. Click the Edit button.

3. Choose your desired action:

a. Using the void option leaves a transaction in the register but
marks it as void and erases the payment or deposit amount.

b. Using the delete option completely removes the transaction from
your register.

Change a Deposit You Entered Incorrectly
If you made an error in your deposit transaction information, making a correc-
tion is easy.

1. Select the deposit from the register.

2. Use the Tab and Shift+Tab keys to move the cursor to the field you
want to change.

3. Make your fix.

4. Click Enter to save the changes.

Change a Transfer You Entered Incorrectly
If you entered the wrong transfer information, you can always make corrections.

1. Select the transfer from the register.

2. Use the Tab and Shift+Tab keys to move the cursor to the field you
want to change.

3. Make your fix.

4. Click Enter to save the changes.
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Find Previous Transactions
To find details about a previous financial transaction — such as to whom a check
was written — follow these steps:

1. Click the Edit drop-down menu.

2. Select Find & Replace, and then click Find.You can also click the
Find button on the Register tab.

3. Enter the piece of text or number that identifies the transaction you
want to locate (see Figure 12-8).

Figure 12-8

4. In the Search field’s drop-down list, select where you want to search.

5. In the Match drop-down list, select how you want Quicken to search.

6. If you clicked the Find button from the register tab, specify whether
you want Quicken to search forward or backward from the selected
transaction by checking or unchecking Search Backwards.

7. Begin your search by clicking Find or Find All:

a. The Find option highlights the matching transactions in the 
register.

b. The Find All option only displays a list of the matches.

8. Browse through any finds (see Figure 12-9).

Figure 12-9
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GLOSSARY

AGP: An Accelerated Graphics Port is the type of connection
used by modern video cards.

broadband modem: The device that connects your PC to the
Internet.You must subscribe to an Internet service provider
(ISP) before accessing the Internet.

CAT5 cable: Also called a Category 5 cable or an Ethernet
cable, it connects computers to devices such as broadband
modems or routers.

dial-up connection: A method for connecting to the Internet
using standard telephone lines and a dial-up modem inside
your PC.

Ethernet: Another name for a CAT5 cable, as well as the
name for the port on a computer or peripheral that a CAT5
cable connects to.

FireWire: A high-performance interface for connecting video
cameras and other peripherals to your PC.

hard drive: The device inside your computer that stores all of
your files and software.

ISP: An Internet service provider is a company that sells
access to the Internet.

MP3: MPEG layer 3 is the most common way to create digital
music files from standard music CDs.

PDA: A Personal Digital Assistant is a small handheld com-
puter that serves as a storehouse for your personal information
(such as names and phone numbers). Some models can even
download e-mail and browse the Internet.
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RAM: Random Access Memory is memory in your computer that stores run-
ning programs as well as associated data. When the electrical power to your PC
is cut off (such as when you shut down the PC), the RAM’s storage is cleared.

RJ-11 plug: A connector at both ends of a telephone cord needed for linking
the telephone modem in your PC to a telephone jack for the purpose of con-
necting to the Internet.

RJ-45 plug: A connector at both ends of an Ethernet (CAT5) cable needed for
linking the Ethernet card in your PC to an Ethernet port on your broadband
modem or wireless router.

surge protector: Provides electrical outlets for your PC, monitor, printer, and
other peripherals, and protects those items from being damaged by electrical
surges caused by lightning storms or power fluctuations.

telephone modem: Hardware that usually installs inside your PC and connects
to the Internet through a standard telephone cord and telephone jack.

UPS: An Uninterruptible Power Supply includes a continuously charged battery
that will operate your PC for a short period of time during a power outage.

USB hub: Universal Serial Bus is a very common interface for connecting a
keyboard, mouse, PDA, printer, or video game controller to a PC.

wireless router: Hardware that provides a wireless interface between PCs hav-
ing wireless cards and the Internet.

WMA: Windows Media Audio is an audio-compression format similar to MP3
but with copy protection and usage-restriction features.

168 Glossary

19_77989x gl.qxp  11/10/05  6:54 PM  Page 168



INDEX
A
About Internet Explorer command, 4
access numbers, dial-up Internet

service, 55
accounts

dial-up Internet service, 54–55
e-mail, 136–139
Quicken database, 161–163

Adapter tab, 21
addresses, IP

obtaining automatically, 64–65
permanent, 65–66

Advanced button (Settings tab), 21
advanced searches, e-mail, 148–149
aligning cells, Excel spreadsheets,

128–129
alternate access numbers, dial-up

connections, 57
AOL (America Online)

e-mail account setup, 137–139
Instant Messenger pop-ups,

stopping, 151
Apple iTunes music store, 83
asset deprecation, Excel spreadsheets,

126–127
Audiograbber music program, 83
AutoFormat feature, Excel

spreadsheets, 124
automated double spacing, Microsoft

Word, 110
automatic e-mail signatures, 145–146

B
backups

Outlook e-mail, 141–142
Quicken database, 159

batteries
backup, 69
coverage, warranties, 50
Flash digital music players, 82
hard-drive digital music

players, 83
laptops, short battery life

problems, 91–92

bill payment options, Quicken
database, 163

blue screen problems,
troubleshooting, 25, 87–88

borders, Excel spreadsheets, 129
browser settings,Works 8 program,

155–156
bullet and number points,

automating, Microsoft Word, 115
buying PCs

computer types, 46
desktops versus laptops, 46–49
hardware requirements, 49
heavy general use computer

type, 46
high performance computer

type, 46
light general use computer

type, 46
reasons for, 45–46
service plans, warranties, 50

C
cable Internet service

connection speed, 54
costs, 54
description, 54
setting up, 56

cables, ribbon, 9
camcorder connections, 78
camera connections, 77–78
casing, equipment inspection, 8
CDs

CD drives
disc and software

determination, 16–17
installing, 34–35

converting to digital songs, 83
cells, Excel spreadsheets

alignment, 128–129
formatting, 128–129
hidden, 132–133
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charts
Excel spreadsheets, 129–130
Microsoft Word

importing data in, 112
inserting data in, 111–112
naming, 111
tables as, 113

cleaning mouse, 71
combo drives, 34
computers. See also PCs

casing, equipment inspection, 8
memory amount determination, 6
old, PC purchasing reasons, 45
overheated, 88

connections, Internet
accessing, 60–61
cable service

connection speed, 54
costs, 54
description, 54
setting up, 56

daily task performance, 53
dial-up service

access numbers, 55
accounts, setting up, 54–55
alternate access numbers, 57
connection speed, 54
costs, 54
description, 54
dial tones, checking for, 56
installing, 36–37
looking for, 19
modem status checks, 56
phone cord replacement, 58
restoring, 56–58
slow connection problems, 57–58

DSL service
connection speed, 54
costs, 54
description, 54
setting up, 55

high-speed, 38
public network connections, 58
troubleshooting

firewalls, disabling, 63–64
IP addresses, obtaining automatically,

64–65
IP addresses, setting permanent, 65–66
rebooting, 63
slow connections, 57–58
wired network connections, 60

types of, 53
wireless

accessing, 60–61
troubleshooting, 61–63

copy protection features, digital music players,
85–86

copying text, Microsoft Word, 108–109
corrupt documents, 133
costs

cable Internet service, 54
desktops, 47
dial-up Internet service, 54
DSL Internet service, 54
Flash digital music players, 82
laptops, 48

CPU
manufacturer determination, 5
speed

determining, 5
hardware requirements, 49

crashes
hard drives, 30
troubleshooting, 87–88

D
data restoration

Outlook e-mail program, 142–143
Quicken database, 160

dBpowerAMP Music Converter music
program, 83

deleting transactions, Quicken database, 164
deposit transactions, Quicken database, 164
Desktop Icons (General tab), 10, 13, 16, 29
desktops

advantages/disadvantages, 47
costs, 47
laptops versus, 46–49
versatility, 47

Device Manager tab
DVD/CD-ROM drives category, 17
Hard disk controllers category, 11

dial-up Internet service
access numbers, 55
accounts, setting up, 54–55
alternate access numbers, 57
connection speed, 54
costs, 54
description, 54
dial tones, checking for, 56
installing, 36–37
looking for, 19
modem status checks, 56
phone cord replacement, 58
restoring, 56–58
slow connection problems, 57–58

digital camcorder connections, 78
digital camera connections, 77–78
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digital music players
assembly, 83–85
battery problems, 85
CDs, converting to digital songs, 83
copy protection features, 85–86
Flash players, 82
hardware requirements, 81–82
online music stores, 83
PC connection problems, 85
songs, loading, 84–85
sound distortion problems, 85
troubleshooting, 85–86
WMA file problems, 85–86

digital rights management (DRM) copy
protection feature, 85

distortion, digital music players, 85
documents

corrupt, 133
Microsoft Word

opening in Works 8 program, 153–154
recovering, 118
text, copying and pasting, 108–109
text, finding and replacing, 109

Works 8 program
document history, clearing, 154
sharing, 153–154

double spacing, automating, Microsoft Word, 110
download settings, Outlook e-mail program,

140–141
driver information, downloading, 67
drives

CD drives
disc and software determination, 16–17
installing, 34–35

combo, 34
DVD drives

disc and software determination, 16–17
installing, 34–35

floppy drives
LED status light, 19
location of, 18–19
replacing, 35–36

hard drives
crashes, 30
digital music players, 82–83
external, adding, 29–30
interface determination, 9–11
internal, adding, 27–29
SATA (Serial ATA), 28
size and remaining space determination,

7–8
troubleshooting, 91

read-only, 34
recordable, 34
rewritable, 34

DRM (digital rights management) copy
protection feature, 85

DSL Internet service
connection speed, 54
costs, 54
description, 54
setting up, 55

DVD drives
disc and software determination, 16–17
installing, 34–35

E
Easy CD-DA Extractor music program, 83
educational source, laptops as, 47
e-mail

accounts, adding, 136–137
AOL accounts, adding, 137–139
backing up, 141–142
default account selection, 139
default application selection, 135–136
download settings, 140–141
folders, creating, 141
programs, default settings, 157
saving, 143–144
searching for, 147–149
sending and receiving

automatically, 146–147
problems, troubleshooting, 144–145

signatures, automatic, 145–146
eMusic store, 83
envelope creating and printing, Microsoft Word,

116–117
equipment inspection, computer casing, 8
errors. See troubleshooting
Ethernet cards, 19–20
Excel spreadsheets (Microsoft)

asset deprecation, 126–127
AutoFormat feature, 124
borders, 129
cells

alignment, 128–129
formatting, 128–129
hidden, 132–133

chart creation, 129–130
corrupt documents, 133
creating, 124
font types, 129
functions, 126–127
moving, 122–123
multiple sheet use, 122–124
#Name? message, 121
previewing as Web page, 133
real-time data, importing, 131–132
renaming, 123
sorting data in, 125
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extended warranties, 50
external hard drives, adding, 29–30

F
finding text, Microsoft Word, 109
firewalls

disabling, 63–64
Norton Personal, 63
ZoneAlarm, 63

FireWire cards
adding, 32–34
port determination, 15–16
scanner connections, 79

Flash digital music players, 82
flicker, monitor image quality, 93–94
floppy drives

LED status light, 19
location of, 18–19
replacing, 35–36

folders, e-mail, 141
font types, Excel spreadsheets, 129
footer and header changes, Microsoft Word, 110
format painter feature, Microsoft Word, 115–116
freezes, troubleshooting, 98
functions, Excel spreadsheets, 126–127

G
games

computer type selection, PC purchases, 46
controller connections, 79
slow or sputtering graphics, troubleshooting,

99
General tab

Desktop Icons, 10, 13, 16, 29
Used space option, 8

H
Hard disk controller category (Device Manager

tab), 11
hard drives

crashes, 30
digital music players, 82–83
external, adding, 29–30
interface determination, 9–11
internal, adding, 27–29
SATA (Serial ATA), 28
size and remaining space determination, 7–8
troubleshooting, 91

hardware
digital music players, 81–82
proper use checks, 101
troubleshooting, 97–98

Hardware tab, 10, 13, 17
header and footer changes, Microsoft Word, 110

heavy general use computer type, PC
purchases, 46

hidden cells, Excel spreadsheets, 132–133
hiding Office Assistant, 105
high performance computer type, PC purchases,

46
high-speed Internet connections, 38
hubs, USB

installing, 69
malfunctioning, 88

I
ink, printer, 76
installations

CD drives, 34–35
dial-up modems, 36–37
DVD drives, 34–35
RAM sticks, 26
software installation, troubleshooting, 95–97
USB hubs, 69

Instant Messenger pop-ups, stopping, 151
interface determination, hard drives, 9–11
internal hard drives, adding, 27–29
Internet connections

cable service
connection speed, 54
costs, 54
description, 54
setting up, 56

daily task performance, 53
dial-up service

access numbers, 55
accounts, setting up, 54–55
alternate access numbers, 57
connection speed, 54
costs, 54
description, 54
dial tones, checking for, 56
installing, 36–37
looking for, 19
modem status checks, 56
phone cord replacement, 58
restoring, 56–58
slow connection problems, 57–58

DSL service
connection speed, 54
costs, 54
description, 54
setting up, 55

high-speed, 38
public network connections, 58
troubleshooting

firewalls, disabling, 63–64
IP addresses, obtaining automatically,

64–65
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IP addresses, setting permanent, 65–66
rebooting, 63
slow connections, 57–58
wired network connections, 60

types of, 53
wireless

accessing, 60–61
troubleshooting, 61–63

Internet Explorer
About Internet Explorer command, 4
default e-mail application, 135–136
version determination, 4

invalid system disk message, 94–95
IP addresses

obtaining automatically, 64–65
permanent, 65–66

ISPs (Internet service providers), 54
iTunes music store (Apple), 83

J
joysticks, video game controller connections, 79
jumper settings, hard drives, 28

K
keyboards

replacing, 73–74
troubleshooting, 99

L
landscape orientation, printer preferences, 75
laptops

advantages/disadvantages, 47–49
costs, 48
desktops versus, 46–49
as educational source, 47
mobility, 48
short battery life, troubleshooting, 91–92

LED status light, flopping drives, 19
lemon policy, warranties, 50
light general use computer type, PC purchases, 46

M
manufacturer determination, processors, 5
margin changes, Microsoft Word, 114–115
memory

adding, 26–27
determining amount of, 6
hardware requirements, 49
RAM (Random Access Memory)

adding, 26–27
determining amount of, 6
installing/removing stick of, 26

Microsoft Excel. See Excel spreadsheets
Microsoft Money program, switching to Quicken

database, 163–164

Microsoft Outlook. See Outlook e-mail program
Microsoft Word. See Word word-processing

program
Microsoft Works 8. See Works 8 program
mobility advantages, laptops, 48
monitors

replacing, 71
troubleshooting

poor image quality, 92–93
screen flicker, 93–94

mounting bay, floppy drives, 36
mouse

cleaning, 71
onscreen cursor movement problems, 71
optical, 73
replacing, 73

moving
Office Assistant, 107
spreadsheet cells, 122–123
toolbars, Microsoft Word, 108

MSN Music store, 83
Music Downloads music store (Wal-Mart), 83
music players, digital

assembly, 83–85
battery problems, 85
CDs, converting to digital songs, 83
copy protection features, 85–86
Flash players, 82
hardware requirements, 81–82
online music stores, 83
PC connection problems, 85
songs, loading, 84–85
sound distortion problems, 85
troubleshooting, 85–86
WMA file problems, 85–86

MusicMatch Jukebox music program, 83

N
#Name? message, Excel spreadsheets, 121
naming charts, Microsoft Word, 111
Napster music store, 83
network cards

adding, 38–39
additional backup cards, 39
checking for, 19–20

Newegg website purchases
CD and DVD drives, 34
external hard drives, 29
FireWire cards, 32
floppy drives, 35
memory sticks, 26
network cards, 38
sound cards, 42
USB cards, 30
video cards, 40
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Norton utilities
Norton Ghost software, 28
Norton Personal firewall, 63

number and bullet points, automating, Microsoft
Word, 115

O
Office Assistant (Microsoft Word)

character, changing, 106
displaying, 106
hiding, 105
moving, 107
settings, changing, 106

old computers, PC purchasing reasons, 45
online account access, Quicken database, 163
online music stores, 83
optical mouse, 73
Outlook e-mail program (Microsoft)

data restoration, 142–143
e-mail

accounts, adding, 136–137
AOL accounts, adding, 137–139
backing up, 141–142
default account selection, 139
default application selection, 135–136
download settings, 140–141
folders, creating, 141
saving, 143–144
searching for, 147–149
sending and receiving, automatically,

146–147
sending and receiving, troubleshooting,

144–145
signatures, automatic, 145–146

overheated computers, troubleshooting, 88

P
parallel-port scanner connections, 80
passwords, Quicken database, 161
pasting text, Microsoft Word, 108–109
PCs

purchasing
computer types, 46
desktops versus laptops, 46–49
hardware requirements, 49
heavy general use computer type, 46
high performance type, 46
light general use computer type, 46
reasons for, 45–46
service plans, warranties, 50

upgrades
CD drives, installing, 34–35
common PC problems, 24
dial-up modems, adding, 36–37

do-it-yourself considerations, 24
DVD drives, installing, 34–35
external hard drives, adding, 29–30
FireWire cards, adding, 32–34
floppy drives, replacing, 35–36
internal hard drive, adding, 27–29
memory, 26–27
network cards, adding, 38–39
reasons for, 23
sound card replacement, 42–43
USB cards, adding, 30–31
video card replacement, 40–41
what to upgrade, 24
to Windows XP, 24–25

PDF file conversion, Microsoft Word, 119
permanent IP addresses, 65–66
personal rights management (PRM) copy

protection feature, 85
phone cord replacement, dial-up Internet

connections, 58
photo editing software, PC purchases, 45
photos, inserting in Word documents, 113–114
pop-ups, stopping, 151
port scanner connections, 80
portrait orientation, printer preferences, 75
ports, USB

location determination, 11–12
version determination, 13–15

power up problems, troubleshooting, 89–91
power-surge protection, warranties, 50
printers

connecting, 74
inks, conserving, 76
landscape orientation, 75
portrait orientation, 75
preferences, setting up, 75–77
print quality levels, 76

printing envelopes, Microsoft Word, 116–117
PRM (personal rights management) copy

protection feature, 85
problems. See troubleshooting
processors, manufacturer and speed

determination, 5
public networks, Internet connections, 58
purchasing PCs

computer types, 46
desktops versus laptops, 46–49
hardware requirements, 49
heavy general use computer type, 46
high performance computer type, 46
light general use computer type, 46
reasons for, 45–46
service plans, warranties, 50
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Q
Quicken database

accounts, setting additional, 161–162
backups, 159
bill payment options, 163
data restoration, 160
online account access, 163
passwords, 161
switching from Microsoft Money program,

163–164
transactions

deposit information, changing, 164
finding previous, 165
transfer information, changing, 164
voiding and deleting, 164

R
RAM (Random Access Memory)

adding, 26–27
determining amount of, 6
installing/removing stick of, 26

read-only drives, 34
real-time data, importing in Excel spreadsheets,

131–132
rebooting, Internet connection problems, 63
receiving e-mail

automatically, 146–147
problems, troubleshooting, 144–145

recordable drives, 34
recovering documents, Microsoft Word, 118
refresh rates, 93–94
renaming Excel spreadsheets, 123
replacing text, Microsoft Word, 109
resolution, monitor image quality, 93
restoration

dial-up Internet service, 56–58
Outlook e-mail program, 142–143
Quicken database, 160

rewritable drives, 34
Rhapsody music store, 83
ribbon cables, 9

S
SATA (Serial ATA) drives, 28
saving e-mail, 143–144
scanner connections, 79–80
screen flicker problems, 93–94
searching

for e-mail, 147–149
previous transactions, Quicken database, 165

sending e-mail
automatically, 146–147
problems, troubleshooting, 144–145

Serial ATA (SATA) drives, 28

service plans, warranties, 50
Settings tab, 21
sharing documents,Works 8 program, 153–154
signatures, e-mail, 145–146
size and remaining space determination, hard

drives, 7–8
slow Internet connections, troubleshooting,

57–58
software

modern software demands, PC purchases, 45
Norton Ghost, 28
proper use checks, 101
troubleshooting, 88, 95–97

songs, loading onto digital music players, 84–85
sorting data, Excel spreadsheets, 125
sound

distortion problems, digital music players, 85
no sound, troubleshooting, 100–101
sound systems, speaker replacement, 70

sound cards, replacing, 42–43
speakers, replacing, 70
speed, CPU

determining, 5
hardware requirements, 49

spreadsheets, Microsoft Excel
asset deprecation, 126–127
AutoFormat feature, 124
borders, 129
cells

alignment, 128–129
formatting, 128–129
hidden, 132–133

chart creation, 129–130
corrupt documents, 133
creating, 124
font types, 129
functions, 126–127
moving, 122–123
multiple sheet use, 122–124
#Name? message, 121
previewing as Web page, 133
real-time data, importing, 131–132
renaming, 123
sorting data in, 125

steering wheels, video game controller
connections, 79

storage capacity
Flash digital music players, 82
hard-drive digital music players, 83

subwoofers, speaker replacement, 70
surge protectors

adding, 68
power-surge protection, warranties, 50

surround-sound systems, 70
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T
tables, charts as, 113
tabs

Adapter, 21
Device Manager

DVD/CD-ROM drives category, 17
Hard disk controllers category, 11

General
Desktop Icons, 10, 13, 16, 29
Used space option, 8

Hardware, 10, 13, 17
Settings, 21

telephone jacks, dial-up Internet service, 19
template paper, printing on, Microsoft Word,

117–118
text, Microsoft Word documents

copying and pasting, 108–109
finding and replacing, 109

time savings, PC upgrades, 23
toolbars, Microsoft Word

displaying, 107
moving, 108

transactions, Quicken database
deposit information, changing, 164
finding previous, 165
transfer information, changing, 164
voiding and deleting, 164

transferable warranties, 50
troubleshooting

blue screen problems, 25, 87–88
corrupt documents, Excel spreadsheets, 133
crashes, 87–88
dial-up connections, slow, 57–58
digital music players, 85–86
freezes, 98
hard drives, 91
hardware, 97–98
Internet connections

firewalls, disabling, 63–64
IP addresses, obtaining automatically,

64–65
IP addresses, setting permanent, 65–66
rebooting, 63
slow connections, 57–58
wired network connections, 60
wireless connections, 61–63

invalid system disk message, 94–95
keyboard connections, 99
laptop battery life, 91–92
monitors

poor image quality, 92–93
screen flicker, 93–94

overheated computers, 88
power up problems, 89–91
software, 88, 95–97

sound control, 100–101
USB hubs, 88
video games, slow or sputtering graphics, 99

U
upgrading PCs

CD drives, installing, 34–35
common PC problems, 24
dial-up modems, adding, 36–37
do-it-yourself considerations, 24
DVD drives, installing, 34–35
external hard drives, adding, 29–30
FireWire cards, adding, 32–34
floppy drives, replacing, 35–36
internal hard drives, adding, 27–29
memory, 26–27
network cards, adding, 38–39
reasons for, 23
sound card replacement, 42–43
USB cards, adding, 30–31
video card replacement, 40–41
what to upgrade, 24
to Windows XP, 24–25

USB devices
cards, adding, 30–31
hubs

installing, 69
malfunctioning, 88

ports
location determination, 11–12
version determination, 13–15

scanner connections, 79
Used space option (General tab), 8

V
versatility, desktops, 47
version determination

Internet Explorer, 4
USB ports, 13–15
Windows, 3–4

video cards
replacing, 40–41
specifications, 21

video editing software, PC purchases, 45
video games

computer type selection, PC purchases, 46
controller connections, 79
slow or sputtering graphics,

troubleshooting, 99
voiding transactions, Quicken database, 164

W
Wal-Mart Music Downloads music store, 83
warranties, PC purchases, 50
Web pages, Excel spreadsheet documents as, 133
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websites, Newegg site purchases
CD and DVD drives, 34
external hard drives, 29
FireWire cards, 32
floppy drives, 35
memory sticks, 26
network cards, 38
sound cards, 42
USB cards, 30
video cards, 40

Windows environment
version determination, 3–4
video card specifications, 21

Windows ME
dial-up connections, restoring, 57
interface determination, 11
laptop battery life problems,

troubleshooting, 92
printer preference configuration, 76–77
screen flicker problems, 94
software installation, troubleshooting, 95
USB version determination, 14–15

Windows Media Audio (WMA) files, 85–86
Windows Media Player music program, 83
Windows 98

dial-up connections, restoring, 57
interface determination, 11
laptop battery life problems,

troubleshooting, 92
printer preference configuration, 76–77
screen flicker problems, 94
software installation, troubleshooting, 95–97
USB version determination, 14–15

Windows 2000
CD and DVD drive identification, 16–17
dial-up connections, restoring, 56–57
interface determination, 10
laptop battery life problems, troubleshooting,

92
printer preferences configuration, 75
screen flicker problems, 93–94
software installation, troubleshooting, 95
USB version identification, 13–14

Windows XP
CD and DVD drive identification, 16–17
dial-up connections, restoring, 56–57
interface determination, 10
laptop battery life problems,

troubleshooting, 92
printer preference configuration, 75
screen flicker problems, 93–94
software installation, troubleshooting, 95
songs, loading onto digital music players,

84–85
upgrading to, 24–25

USB version identification, 13–14
wireless Internet connections, 61–63

wired Internet connections, troubleshooting, 60
wireless cards, checking for, 19–20
wireless Internet connections

accessing, 60–61
troubleshooting, 61–63

WMA (Windows Media Audio) files, 85–86
Word word-processing program (Microsoft)

bullet and number points, automating, 115
charts

importing data in, 112
inserting data in, 111–112
naming, 111
tables as, 113

document recovery, 118
documents, opening in Works 8 program,

153–154
double spacing, automating, 110
envelope creation and printing, 116–117
format painter feature, 115–116
header and footer changes, 110
margin changes, 114–115
Office Assistant

character, changing, 106
displaying, 106
hiding, 105
moving, 107
settings, changing, 106

PDF file conversion, 119
photos, inserting in documents, 113–114
template paper, printing on, 117–118
text

copying and pasting, 108–109
finding and placing, 109

toolbars
displaying, 107
moving, 108

Works 8 program (Microsoft)
AOL Instant Messenger pop-ups, stopping,

151
default browser settings, 155–156
document history, clearing, 154
document sharing, 153–154
e-mail program, setting default, 157
Microsoft documents, opening, 153–154
previous version documents, opening from,

152–153

Y
Yahoo Music Unlimited music store, 83

Z
ZoneAlarm firewall, 63
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